ﬁ LibreOffice

Getting Started Guide
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Co je Calc?

Program Calc tabulkovy procesor baliku LibreOffice. Do seSitll miiZzeme vkladat data (obvykle
Ciselnd) a pak s nimi pracovat tak, abychom ziskali urcité vysledky.

Je také moZné zadat data a pak pouzit Calc pro Glohy typu ,Co kdyz...“: nékteré z udajl
zménime a zkoumame, jak se zméni vysledky, aniz bychom museli vytvaret novy sesit nebo list.

Program Calc nabizi mimo jiné nasledujici funkce:
« Funkce, které Ize pouZzit k vytvareni vzorcl umoZziujicich provadét s daty komplexni
vypocty.
» Databazové funkce umozfiujici data fadit, ukladat a filtrovat.
e Dynamické grafy, véetné Siroké sSkaly 2D a 3D graf(.

¢ Makra pro zaznamenavani a spousténi ¢asto opakovanych tkol(l. Mezi podporované
skriptovaci jazyky na tvorbu maker patfi LibreOffice Basic, Python, BeanShell
a JavaScript.

* Schopnost otevirat, upravovat a ukladat seSity programu Microsoft Excel.

* Importovat a exportovat seSity v mnoha forméatech vcetné HTML, CSV, PDF
a PostScriptu.

Kompatibilita s jinymi tabulkovymi procesory

Zastupné znaky

Zakladni zastupné znaky, jako je hvézdicka (*), otaznik (?) a vinovka (~) z jinych tabulkovych
aplikaci, dokéze v zépisu vzorce rozpoznat i LibreOffice.

Syntaxe vzorcu

Ve vychozim nastaveni pouziva LibreOffice Calc svou vlastni syntaxi vzorc(l ozna¢ovanou jako
Calc Al namisto syntaxe vzorcl Excel Al, kterou pouziva Microsoft Excel. LibreOffice dokaze
bezproblémoveé pfevadét mezi obéma typy syntaxi. | kdyZ pokud jsme zvykli pracovat s Excelem,
mlZeme si vychozi syntaxi v programu Calc zménit v nabidce Nastroje > MozZnosti >
LibreOffice Calc > Vzorec, kde vybereme Excel A1 nebo Excel R1C1 v rozeviracim seznamu
Syntaxe vzorcd.

Vice informaci o syntaxi vzorcll se nachazi v kapitole 7, Pouziti vzorcl a funkci, v pfirucce Calc.

Makra.

Microsoft Office pouziva jazyk Visual Basic for Applications (VBA), LibreOffice pouZziva jazyk
Basic zaloZeny na LibreOffice API. ACkoliv jsou programovaci jazyky stejné, objekty a metody
jsou rozdilné, a proto nejsou zcela kompatibilni.

LibreOffice dokaze spoustét nékteré skripty Visual Basic z Excelu, pokud tuto funkcionalitu
umoznime v menu Nastroje > Moznosti > Nacist/Ulozit > Vlastnosti VBA.

Pokud chceme v LibreOffice pouzivat makra vytvorena v jazyce VBA v programu Microsoft Excel,
musime nejprve v editoru LibreOffice Basic IDE upravit jejich kéd.

Vice informaci se nachazi v kapitole 12, Makra v programu Calc, v pfiru¢ce Calc.
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SeSity, listy a bunky

Calc pracuje s dokumenty ozna¢ovanymi jako seSity. Sesit se sklada z nékolika jednotlivych listd,
kazdy list se sklada z bunék, které jsou usporadany do fadkd a sloupct. Urcita burika se da
identifikovat podle €isla fadku a pismene sloupce.

V bunkach jsou ulozeny jednotlivé prvky (text, Cisla, vzorce atd.), které umoZznuji zobrazovat
a zpracovavat data.

Kazdy sesit mGze mit aZz 10 000 listd a kazdy list miize mit maximalné 1 048 576 rfadkl a 1024
sloupcd.

Hlavni okno programu Calc

s w7

Po spusténi programu Calc je otevieno hlavni okno (obrazek 85). Jeho hlavni ¢asti jsou popsany
nize. Mnoho ¢asti miiZzeme zobrazit nebo skryt pomoci nabidky Zobrazit v hlavni nabidce.

Hlawvni Standardni Mastrojova lista
nabidka nastrojova lista formatovani

B Bez néza 1 - LibreDffice Calc
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Obrazek 85: Hlavni okno programu programu Calc

Zahlavi okna

V zahlavi okna, umisténém v horni ¢asti, se zobrazuje nazev aktualniho seSitu. Kdyz je sesit
noveé vytvoreny z Sablony nebo prazdného dokument, ma jméno Bez nazvu X, kde X je &islo.
Kdyz sesit ukladdme poprvé, zobrazi se vyzva k zadani nazvu.

Hlavni nabidka

Pod zahlavim okna se nachazi hlavni nabidka. Jestlize zvolime nékterou z poloZzek nabidky,
smérem dolll se zobrazi nabidka s pfikazy. Hlavni nabidku mdzeme pfizplsobit; vice informaci
o tomto tématu se nachazi v kapitole 14 — Pfizplsobeni LibreOffice.
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VétSina nabidek je podobna jako v jinych komponentach LibreOffice, ackoliv specifické prikazy
a nastroje se mohou lisit. Nabidky specifické pro Calc jsou List a Data; navic dal3i dllezita data
analytickych nastrojl se nachazeji v nabidce Nastroje.

List
Nejcastéji pouzivane prikazy pro praci s listy, jako jsou Vlozit a Smazat buriky, Sloupce,
Réadky a Listy; vybrat Typ odkazu na burku; Odkaz na externi data.

Data
Pfikazy pro préaci s daty v sesit&; napfiklad Definovat oblast, Radit, Filtry, Statistiky,
Kontingencéni tabulky, Konsolidovat, Formulare, Seskupeni a souhrny.

Nastroje
Funkce, které pomahaji kontrolovat a pfizpUsobit sesit; naptiklad Kontrola pravopisu,
Makra, Hledat feSeni, Resitel, Scénare, Detektiv, Uzamknout list, Nastaveni XML filtru
a Spravce rozsifeni.

Nastrojové listy
Ukotvena nastrojova lista, ktera se ve vychozim nastaveni nachazi v horni ¢asti pfimo pod hlavni

nabidkou, se nazyva Standardni lista. Je stejna ve vSech modulech baliku LibreOffice. Jeji
umisténi a pouZiti a daldi panely nastrojll jsou popsany v kapitole 1, Uvod do LibreOffice.

LiSta vzorcu

LiSta vzorcll (obrazek 86) je umisténa na horni ¢asti listu v prostfedi pro vypodty. V této poloze je
trvale ukotvena a nelze ji pouzit jako plovouci nastrojovou listu. Nicméné miZe byt skryta nebo
zobrazena pomoci Zobrazit > Lista vzorct v hlavni nabidce.

C10 v fx 2 == v
Obréazek 86: Lista vzorcli

Lista vzorcll zahrnuje zleva doprava nasledujici:

Pole nazvu — zobrazuje aktualni odkaz na aktivni buriku, ktery sestava z kombinace
pismen a Cislic, napfiklad A1l. Pismeno znaci sloupec a cCislo radek vybrané burky. Pokud
jsme oznadili ur€itou oblast bunék, které se takeé fika rozsah, potom je nazev oblasti
uveden v této kolonce. Pro pfesun na danou buriku mizeme zadat odkaz v Poli ndzvu.
Pokud zaddme néazev oblasti a stiskneme tlaCitko Enter, pojmenovana oblast se vybere

a zobrazi.

Priivodce funkci — otevie dialogové okno, kde miizeme vyhledavat dostupné funkce. To
mUze byt také velmi uzitené pro zobrazeni toho, jak jsou funkce definovany.

>Vybrat funkci — tento rozbalovaci seznam nabizi pét moZnosti: Soucet, Priimér,
Minimum, Maximum a Pocet (obrazek 87).

Al viifx &» =
B Soucet
d ‘ Pramér ]
2 Minimum
3 Maximum
: Pocet

Obrézek 87: Rozbalovaci seznam Vybrat funkci
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Vzorec — vlozi do vybrané buriky a do vstupniho radku znaménko rovna se (=), coz
umoznuje zadani vzorce. Pole nazvu nyni zobrazi rozbalovaci seznam s nejcastéji
pouzivanymi funkcemi pro rychly pfistup k ndzvu funkce a syntaxi.

Vstupni fadek — zobrazuje obsah vybrané burky (data, rovnice nebo funkce) a umoznuje
jeho Gpravu. Pokud jej chceme zménit na vicefadkovy pro zadavani velmi dlouhych vzorcd,
klepneme na tlagitko s Sipkou dold na pravé strané Vstupniho radku.

Obsah buriky mGzeme upravit také pfimo poklepanim na buriku. KdyZ do buriky zadame nova
data, ikony Vyberte funkci a Vzorec se zméni na ikony Zrusit a Pfijmout.
Poznamka

Pojem ,funkce” v seSitech zahrnuje mnohem vic nez jen matematické funkce. Vice
informaci se nachazi v kapitole 7, Pouzivani vzorcl a funkci v pfirucce Calc.

Stavovy fadek

Stavovy fadek programu Calc (obrazek 88) poskytuje informace o seSitu a také rychly a pohodiny
zpUsob jak zménit nékteré z jeho vlastnosti. Vétsina z poli je podobna tém v ostatnich
soucastech LibreOffice; vice informaci se nachazi v kapitole 1 — Uvod do LibreOffice.

ReZim

Cislo Styl Vidsdani nebo MeuloZene Infirmace
listu stranky Zmeny O bufkach a objektech
i i prepisovani / /
| List 12 1] Vybrino: 7 fadkl, 2 sloupce | Vichoai Ceitipa 2 |23 | Soudet: (; Polet vybramjch: 14| — —8—+ | 100 %
Informace T T \
o vyberu Jazyk ReZim Digitalni Posuvnik Faktor
bunék textu  vybé&ru | podpis ZvetSeni ZvétSeni v %

s vz

Obrazek 88: Stavovy radek programu Calc

Stavovy fadek umoziiuje rychly pfistup k nékterym matematickym operacim s vybranymi
burikami v sesité. MiZeme pocitat prdimér a soucet, pocitat prvky a dal$i matematické funkce na
vybranych bufikadch pomoci klepnuti pravym tlacitkem nad oblasti informaci o burice ve
Stavovém Fadku a nasledné si vybereme operace, které chceme ve Stavovém fadku zobrazit.

Postranni lista

Postranni liSta programu Calc (Zobrazit > Postranni liSta nebo Ctrl + F5) se nachazi na pravé
strané okna. Jedna se o kombinaci nastrojové listy a dialogového okna. Je to podobné jako
v postranni listé pro Writer (viz kapitoly 1 a 4 této knihy) a sklada se z péti karet: Vlastnosti,
Styly, Galerie, Navigator a Funkce. Kazd4 karta ma svou ikonu na panelu karet, nachazejicim
se vpravo od postranni listy, ktery umoZziuje mezi kartami prepinat. Jednotlivé karty jsou popsany
nize.
Vlastnosti
Tato karta obsahuje pét paneld. Tyto panely, s vyjimkou panelu Styl, ma tlacitko Dals$i
moZnosti, které otevira dialogové okno s dalSimi moznostmi. Tato dialogova okna
uzamknou dokument pro Upravy, dokud nebudou uzaviena.

Styl: Pristup k dostupnym stylim bunék, aktualizaci styl( buné&k a novym styliim bunék.

Znak: Ovladaci prvky pro formatovani textu, jako je napfiklad pismo, velikost a barva.
Neékteré ovladaci prvky, jako je napfiklad horni index, se stanou aktivni pouze tehdy, kdyz
je ve Vstupnim radku LiSty vzorcd nebo v burice textovy kurzor.
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Format &isla: Rychla zména formatu Cisel v€etné desetinnych mist, mény, data, procent
nebo Ciselného textu; tvodni nuly.

Zarovnani: Ovladaci prvky pro zarovnani textu rliznymi zplsoby, véetné vodorovného
a svislého, dale zalomeni, odsazeni, sluCovani, orientace textu a svislé zarovnani.

Vzhled bunky: Ovladaci prvky pro nastaveni vzhledu bunék, v€etné barvy pozadi buriky,
formatu ohraniceni bunky (v€etné barvy ¢ary a stylu) a mrizky.

Styly, Galerie, Navigator
Tyto karty jsou podobné tém v aplikaci Writer. Jejich pouziti je podrobné&ji popsana
v pfirucce Calc.

Funkce
Tato karta obsahuje seznam funkci uspofadanych do kategorii. Je to zjednoduSena verze
Prlivodce funkci, ktery je mozné oteviit volbou VloZit > Funkce z hlavni nabidky, klepnutim
na ikonu Privodce funkci na listé vzorcl nebo stisknutim Ctrl + F2.

Rozvrzeni seSitu

Jednotlivé burniky

Hlavni ¢ast pracovni plochy v programu Calc zobrazuje buriky ve formé mfizky. Kazdéa burika je
tvorena prisecikem sloupce a rfadku v sesité.

V horni ¢asti sloupcl a na levém konci fadkd jsou obdélnikova zahlavi obsahujici pismena
a Cislice. Zahlavi sloupcl pouzivaji pismena zac¢inajici od A a pokracuji doprava. Zahlavi fadk(
pouzivaji ¢isla zac¢inajici od 1 a pokracuji dold.

Tato zahlavi sloupct a fadkd tvori odkazy na buriky, které se zobrazi v Poli nazvu na Listé vzorc(
(obrazek 86). V pripadé, ze v seSité nejsou viditelna zahlavi, vybereme v hlavni nabidce
Zobrazit > Zobrazit zahlavi.

Karty list(

Kazdy sesit programu Calc miZe obsahovat vice listd. V dolni ¢asti mFizky bunék jsou karty listd,
pomoci kterych pozname, kolik listl je v otevieném sesité. Ve vychozim nastaveni je vytvoren
novy sesit s jednim listem pojmenovanym List1. Klepnutim na kartu list zobrazime. Aktivni list je
oznacen kartou bilé barvy (vychozi nastaveni Calcu). MdZeme také vybrat vice listll tim, ze
béhem klepani na karty listl podrzime klavesu Ctrl.

Chceme-li zménit vychozi nazev listu (Listl, List2 a tak dale), klepneme pravym tlaCitkem mysSi
na kartu listu a z mistni nabidky vybereme Pfejmenovat list nebo dvojitym klepnutim na kartu
listu otevieme dialogové okno Prejmenovat list, kde miiZzeme zapsat nové jméno listu.

Chceme-li zménit barvu karty listu, klepneme pravym tlacitkem mySi na kartu a vybereme ze
zobrazené nabidky Barva karty. Otevie se dialogové okno Barva karty. Vybereme barvu

a klepneme na OK. Vice informaci o pfidavani novych barev do palety se nachazi v kapitole 14 —
Prizplsobeni LibreOffice.

Otevirani souboru CSV

Soubory CSV (Comma-separated values) jsou soubory seSitu v textovém formatu, ve kterych je
obsah bunék oddélen znakem, napfiklad ¢arkou nebo stfednikem. Kazdy fadek predstavuje
fadek v tabulce. Text je vioZen v uvozovkach; Cisla se vkladaji bez uvozovek.
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& Poznamka

Vétsina soubori CSV pochazi z databazovych tabulek, dotaz( nebo sestav, kdy jsou
vyZzadovany dalSi vypocty a grafy. V operacnim systému Microsoft Windows maji tyto
soubory Casto pfiponu .xIs, aby vypadaly jako soubor aplikace Excel, ale jsou stale

interné CSV souborem.

Chceme-li otevfit soubor CSV v Calcu:

1) V hlavni nabidce vybereme Soubor > Otevfit a vyhleddme soubor CSV. VétSina CSV
soubor(i ma priponu .csv. Nékteré soubory CSV vSak mohou mit pfiponu .txt.

2) Vybereme soubor a klepneme na tlacitko Otevfit.

3) V dialogovém okné Import textu (obrazek 89), vybereme poZzadované moznosti pro
import CSV souboru do seSitu programu Calc. Vice informaci o téchto mozZznostech

nalezneme v kapitole 1, Uvod do programu Calc v pfiru¢ce aplikace Calc.

4) Klepnutim na tla¢itko OK soubor importujeme.

Import textu - [Seznam%20obci.csv]

Importovat

Znakova sada:

Jazyk: Vychozi - Cestina

-

Od fadku: 1 :

Moznosti oddélovace

® Oddéleno pomoci
COMezera  Oliny

(2 Pevna sitka

Tabulator Carka Strednik

[ Sloucit oddélovace [ Ofiznout mezery

Ostatni mozZnosti

(] Formatovat pole v uvozovkach jako text [] Detekovat specialni ¢isla

Oddélovac fetézca: " |~

Pole
Standardni |Standardn|' |Standardn|' Standardr ~
1 Dbec Kod-obce Povéreny udrad Kod-POU
2 Arnedtovice 509388 Pelhifimov 61102
3 Arnolec 586854 Polna 61052
4 Pabice 590274  Moravske Bud&jovice 61062
c Bacovice 561118  Pelhfimov 61102
g Bacice 590232 Hrotovice 61131
7 Backov 546194 Havlickdv Brod 61022
g Packovice 544833 Jemnice 61061
o Balinv 595217 Velké Mezifiéi 61142 ¥
< >
Mapovéda OK Zrusit

Obrazek 89: Dialogové okno Import textu
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Ukladani sesitu

Vice informaci o manualnim nebo automatickém ukladani najdeme v kapitole 1 — Pfedstavujeme
LibreOffice. V programu Calc je mozné ukladat sesity v riiznych formatech a je také mozné sesity
exportovat do souborli formatu PDF, HTML, XHTML nebo obrazkovych forméatli JPEG a PNG;
vice informaci se nachazi v kapitole 6, Tisk, exportovani, posilani e-mailem a podepisovani

v pfirucce aplikace Calc.

Ukladani do jinych formatt sesitu
Sesit mdZzeme ulozit v rliznych forméatech:

1) UloZime seSit do souborového formatu Calc (*.ods).
2) V hlavni nabidce zvolime Soubor > Ulozit jako, ¢imz otevieme dialogové okno Ulozit
jako.
3) Do pole Nazev souboru mizeme zadat novy nazev souboru.
4) V rozbalovacim seznamu Typ souboru vybereme typ formatu seSitu, ktery chceme pouZzit.
5) Pokud vybereme Automaticka pfipona nazvu soubor(, k nazvu souboru se vybere
a prida spravna pfipona pro zvoleny forméat sesitu.
6) Klikneme na tlacitko Ulozit.
Pokud ukladame seSit v jiném formatu nez .ods, zobrazi se dialogové okno Potvrdit format
souboru (obrazek 90). Klepnutim na tlac¢itko Pouzit format [xxx] budeme v ukladani ve
vybraném formétu seSitu pokracovat, klepnutim na tlacitko PouZzit format ODF uloZime sesit

v forméatu ODS, pro Calc. Pokud zruSime zaSkrtnuti policka Upozornit pfi ukladani v jiném
formatu neZ ODF nebo vychozim, tento dialog se pfi dalSim ukladani v jiném formatu jiz

nezobrazi.
Potvrdit format souboru X

Dokument miZe obsahovat formatovani nebo obsah, jehoZ
uloZeni nemusi vybrany format soubort ,Excel 2007-365"
podporovat.

Aby bylo jisté, Ze se dokument uloZi spravné, pouZijte k jeho uloZeni vychozi
forméat soubord ODF.

Zeptat se pfi ukladani do jiného formatu neZ ODF nebo vychoziho

| Pouzit format Excel 2007-365: | | Pougit format ODF

Obrazek 90: Dialogové okno Potvrdit forméat souboru

Pokud je vybran format Text CSV (*.csv), otevie se dialogové okno Exportovat textovy soubor
(obrazek 91). Zde miiZzeme vybrat znakovou sadu, oddélovac pole, oddé&lovac fetézci (textu)
a tak dale, které maji byt pouzity pro soubor CSV.
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Exportovat textovy soubor X

MozZnosti pole

Znakova sada:
Oddélovac pole: ) b
Qddélovac fetézcl: |" b
UloZit zobrazeny obsah buriky

[ Misto vypoéitanych hodnot bunék uloZit vzorce

[ Textové burky do uvozovek

(] Pevna ifka sloupce

Napovéda Zrudit

Obrazek 91: Dialogové okno pro CSV soubory
Exportovat textovy soubor

@ Poznamka

Jakmile tabulku uloZime v jiném formatu, vSechny zmény, které v tabulce
provedeme, se nyni projevi pouze ve formatu, ktery pouzivame. Pokud se chceme
vratit k praci s verzi dokumentu ve formatu *.ods, musime soubor uloZit ve formatu
*.0ds.

6 Tip

Chceme-li, aby Calc ukladal seSity ve vychozim nastaveni v jiném formatu nez
vychozim formatu ODS, pfejdeme do nabidky Nastroje > MoZnosti > Nac€ist/Ulozit
> Obecné. V sekci Vychozi format soubori a nastaveni ODF vybereme v Typ
dokumentu polozku Sesit a poté vybereme preferovany format souboru v VZdy
ukladat jako.

Export obsahu jako obrazku

Pokud nékomu chceme poslat ¢ast sesitu nebo ji publikovat na internetu, miizeme exportovat
oblast vybé&ru nebo vybranou skupinu objektd (obrazk() do grafického formatu PNG nebo JPG:

1) Vybereme rozsah bunék nebo skupinu objektll a potom zvolime Soubor > Exportovat.

2) V dialogovém okné Exportovat napiSeme nazev obrazku, zvolime graficky format
souboru a oznacime zaSkrtavaci pole Vybér.

3) Klepneme na Export nebo UloZit, podle toho, co mame zobrazeno.

Program Calc m(iZe otevrit dalsi dialogové okno pro konfiguraci nastaveni souvisejicich
s vybranym grafickym forméatem.

Pohyb v seSitech

Program Calc nabizi mnoho zptsobl, jak se v sesité pohybovat z buiiky na buriku a z listu na
list. MGZeme zvolit ten, ktery ndm nejvice vyhovuje.

Pohyb mezi bunkami

KdyZz buiku vybereme nebo oznacime, zvyrazni se jeji ohranieni. Kdyz vybereme skupinu
bunék, vybarvi se jejich plocha. Barva ohraniCeni buriky a skupiny vybranych bunék zavisi na
pouzivaném operacnim systému a na nastaveni LibreOffice.
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Mys: umistime ukazatel mySi nad buriku a klepneme levym tlacitkem mysi.

Odkaz na buiiku: smazeme existujici odkaz na buriku v Poli ndzvu na Panelu vzorcl
(obrazek 86 na strané 141). Zadame novy odkaz na bunku a stiskneme klavesu Enter.
V odkazech na buriku nerozliSujeme velikost pismen.

Navigator: stiskneme klavesu F5 pro otevieni dialogového okna Navigatoru (obradzek 92)
nebo klepneme na tlacitko Navigator v postranni listé. Zadame odkaz na buriku do poli
Sloupec a Radek nebo tlaCitko pro sniZzeni/zvySeni, které najdeme vedle pole a stiskneme

klavesu Enter.

Sloupec: A = | N 4
Radek: |1 2l Mmeo -~

= B Listy

Seznam strojd
Kategorie strojl
Kontrolni list
Karty stroju

¢Z) Nazvy oblasti

= Databazové oblasti

[* Propojené oblasti

(el Obrazky

& Objekty OLE

[ 1 Komentare

¥ Objekty kresby

Bez nazvu 1 (aktivni) ~

Obrazek 92: Navigator

Klavesa Enter: pfesune zaméreni buriky ve stejném sloupci doli na nasledujici fadek.
Shift + Enter pfesune zaméfeni ve sloupci nahoru na predchozi fadek. Mdzeme zménit
akci, ktera se provede po stisknuti klavesy Enter; vice informaci se nachazi v kapitole

Prizplsobeni klavesy Enter na strané 149.

Klavesa tabulatoru: pfesune zaméreni buriky na stejném radku doprava do nasledujiciho
sloupce. Shift + Tab pfesune zaméreni bunky na stejném radku doleva do pfedchazejiciho
sloupce.

Klavesy smérovych Sipek: klavesy smérovych Sipek na klavesnici pfesunou zaméfeni na
burniku ve sméru, kterym Sipka na stisknuté klavese ukazuje.

Klavesy Home, End,Page Up a Page Down:

Home pfesune zaméreni burky na zaCatek Fadku.

End aktivuje Uplné posledni buriku zprava, ktera obsahuje na daném fadku Udaje.
Page Down ptresune zaméreni buriky o jednu obrazovku dold.

Page Up pfesune zaméreni buriky o jednu obrazovku nahoru.
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Pohyb meazi listy

Kazdy list v seSité je nezavisly na ostatnich listech, ackoli odkazy mohou propojovat jeden list
s druhym. Jak se pohybovat mezi listy v seSité:

Navigator — dvojklikem na kterykoliv ze zobrazenych listli se na tento list pfesuneme.

Klavesnice — Ctrl + Page Down pfesune jeden list vpravo a Ctrl + Page Up presune jeden
list vlevo.

Mys — kliknutim na kartu listu v dolni ¢asti tabulky vybereme dany list.

Pokud sesit obsahuje velké mnoZstvi listll, nékteré z karet mohou byt skryty za vodorovnym
posuvnikem v dolni ¢asti obrazovky. Je-li tomu tak:

« Pomoci Gtyr tlagitek vlevo od zaloZek listll, miZzeme skryté karty zobrazit (obrazek 93).

* Klepnutim pravym tlaCitkem mySi na nékterou ze Sipek nebo tlagitko + otevieme mistni
nabidku, v niz mdZeme vybrat list (obrazek 94).

4 Poznamka

KdyZ do seSitu vlioZzime novy list, Calc automaticky k jeho pojmenovani pouZzije dalSi
Cislo v poradi. V zavislosti na tom, jaky list mame aktivni, kdyz vkladame novy list,

a jakym zptsobem list vkladame, nemusi mit novy list spravnou numerickou pozici.
Listy v seSité se doporucuje pfejmenovat tak, aby byly snadnéji rozpoznatelné.

Presunout na prvni list

Pfesunout na pfedchazejici list vlevo
Pfesunout na nasledujici list vpravo
Pfesunout na posledni list

Zalozky listh

M4 » P 4 List2 List3  Listd  Lists  List  List7
List 2 z 21 Vychozi
Obrazek 93: Pohyb mezi zaloZkami list(

10
11
I Listt
B List2
u List3
— List4
- Lists
Listé
List7

<

| List1 List2 List3 Lig

Obrazek 94: Klepnuti pravym tlacitkem mysi
na nékteré z tlaCitek Sipky

Pohyb pomoci klavesnice

V sesité se miizeme pohybovat pomoci klaves, a to stiskem klavesy nebo kombinaci klaves.
V pfiloze A — Klavesové zkratky, v pFiru¢ce Calc najdeme vice informaci o tom, které klavesy
a kombinace klaves mizeme pouZivat pro pohyb v sesité v programu Calc.
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Prizplisobeni klavesy Enter

Smeér, kterym klavesa Enter pfesune zaméreni buriky, mizeme upravit v nabidce Nastroje >
MoZnosti > LibreOffice Calc > Obecné. Pouzijte prvni dvé moznosti v ¢asti Nastaveni vstupu
(obrazek 95) a zménime nastaveni klavesy Enter. Z rozbalovaciho seznamu vybereme smér,
kterym se zaméreni bunky pfesune. Klavesu Enter Ize také pouzit k pfepinani do a z editacniho
rezimu.

Nastaveni vstupu

Stisk klavesy Enter presune vybér %Dmlﬂ

[ Stisk klavesy Enter pfepne reZim U Dold
[ Rozaitit formatovani Doprava
(1 Roz&iit odkazy pfi viozeni nowych{ @O s Fadiki

- . . . . Doleva
L] Pfi fazeni oblasti bunék aktualizovs

Zvyraznit vybér v zahlavi sloupct a radka

L] Pro formatovani textu pouZit metriku tiskarny

Pri vkladani dat zobrazit upozornéni na prepsani
[] Posouvat odkaz na buriku s vybérem

Obrazek 95: Prizplisobeni klavesy Enter

Vybér polozek v seSité

Vybér bunky
Jedna bunka

Klepneme levym tlacitkem na buriku. Svou volbu si mizeme ovéfit v poli nazvu na panelu vzorc(
(obrazek 86 na strané 141).

Souvisla oblast bunék
Oblast bunék Ize vybrat pomoci klavesnice nebo mysi.
Chceme-li vybrat oblast bunék tazenim kurzoru mysi:

1) Klepneme na burku.
2) Stiskneme a podrzime levé tlaCitko mysi.
3) Presuneme my$ a zvyraznime pozadovanou oblast bunék a potom pustime tlacitko na
mysSi.
Chceme-li vybrat oblast bunék bez tazeni mysi:
1) Klepneme do buriky, kterda ma byt jednim z roh( oblasti.

2) PodrZzime klavesu Shift a klepneme do buriky v protilehlém rohu oblasti bunék, kterou
chceme oznacit.

0 Tip

Souvislou oblast bunék mizeme vybrat i tak, Ze nejdfive klepneme do pole ReZim
vybéru ve stavovém fadku (obrazek 88 na strané 142), v nabidce zaskrtneme
RozSifit vybér a nasledné klepneme do opacného rohu oblasti, kterou chceme
vybrat. Ujistime se, Ze jsme zménili volbu, zpét na Standardni vybér, nebot jinak
mUZeme nadale vybér bunék nelmysiné rozsirovat.
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Chceme-li vybrat oblast bunék bez pouZziti mysi:

1) Vybereme buriku, ktera bude jednim z roh( oblasti bunék.
2) Podrzime klavesu Shift a pomoci kurzorovych Sipek vybereme zbytek oblasti.

6 Tip

Oblast bunék miZzeme také vybrat pomoci Pole ndzvu. Klepneme do Pole nazvu na
Panelu vzorcl (obrazek 86 na strané 141). Zadame odkaz na levou horni burku
nasledovany dvojteCkou (:) a odkazem na pravou dolni buriku. Chceme-li napfiklad
vybrat oblast, kterd se bude rozkladat od burnky A3 aZ po C6, zadame A3: C6.

Nesouvisla oblast bunék
1) Vybereme buiiku nebo oblast bunék pomoci jedné z vy3e uvedenych metod.
2) Presuneme ukazatel mysi na zacatek nasledujici oblasti nebo jediné buriky.

3) Podrzime klavesu Ctrl a klepnutim nebo pfetazenim vybereme jinou oblast bunék, kterou
chceme pridat k prvni oblasti.

4) Opakujeme podle potieby.

Vybér sloupct a fadki
Jediny sloupec nebo fadek

KdyZz chceme vybrat jeden sloupec, klepneme na jeho z&hlavi (obrdzek 85 na strané 140).
Chceme-li vybrat jediny fadek, klepneme na zahlavi radku.

Vice sloupcti nebo fadku
Chceme-li vybrat vice sloupcl nebo radkd, které jsou souvisle vedle sebe:
1) Klepneme na prvni sloupec nebo fadek ve skupiné.
2) Podrzime klavesu Shitt.
3) Klepneme na posledni sloupec nebo rfadek ve skupiné.
Chceme-li vybrat vice sloupcll nebo radkd, které nejsou souvisle vedle sebe:
1) Klepneme na prvni sloupec nebo radek ve skupiné.
2) Podrzime klavesu Citrl.
3) Klepneme na vSechny dalsi sloupce nebo Fadky, zatimco drzime klavesu Citrl.
Cely list
Chceme-li vybrat cely list, klepneme na obdélnicek v rohu mezi zahlavim sloupce A a zahlavim

fadku 1 (obrazek 96) nebo pouzijeme kombinaci klaves Ctrl +Shift + Mezernik nebo zvolime
v hlavni nabidce Upravy > Vybrat vSe.

Obrazek 96: Obdélnik pro vybér celého listu
Vybér listl

V Calcu si miizeme vybrat bud jeden, nebo vice listd. Vybér vice listd mlze byt vyhodny, pokud
chceme provést zmény v mnoha listech najednou.
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Jeden list

Klepneme na kartu listu, ktery chceme vybrat. Karta vybraného listu zbéla (ve vychozim
nastaveni Calcu).

Nékolik sousedicich listl
Chceme-li vybrat nékolik sousedicich listd:
1) Klepneme na kartu prvniho pozadovaného listu.
2) Podrzime klavesu Shift a klepneme na zaloZku posledniho poZadovaného listu vybéru.

3) VSechny karty mezi témito dvéma vybéry zbélaji (ve vychozim nastaveni programu Calc).
VSechny akce, které nyni provedeme, ovlivni vSechny zvyraznéné listy.

Nékolik nesousedicich listl

Chceme-li vybrat nékolik nesousedicich listd:
1) Klepneme na kartu prvniho poZzadovaného listu.
2) Podrzime klavesu Ctrl a klepneme na karty listd, které chceme pfidat do vybéru.
3) Vybrané karty zbélaji (ve vychozim nastaveni programu Calc).

VSechny listy

Klepneme pravym tlacitkem mysi na kartu libovolného listu a z mistni nabidky zvolime Vybrat
vSechny listy nebo vybereme z hlavni nabidky volbu Upravy > Vybrat > Vybrat vSechny listy.

Prace se sloupci a radky

Vkladani sloupci a radka
Jediny sloupec nebo fadek
Pomoci nabidky List:

1) Vybereme burku, sloupec nebo fadek podle toho, kam chceme novy sloupec nebo fadek
vlozit.

2) Zvolime v hlavni nabidce List a vybereme bud VloZit sloupce > Sloupce pied, nebo
Vlozit sloupce > Sloupce za, nebo Vlozit fadky > Radky nad, nebo VloZit fadky >
Radky pod.

Pomoci mysi:
1) Vybereme sloupec nebo fadek podle toho, kam chceme novy sloupec nebo Fadek viozit.
2) Klepneme pravym tlacitkem mysi na zéahlavi sloupce nebo rfadku.

3) Z kontextové nabidky zvolime VloZit sloupce pfed, Vlozit sloupce za, Vlozit fadky nad
nebo Vlozit fadky pod.

Vice sloupcti nebo fadkd
Je vhodnéjsi vlozZit vice sloupcd nebo Ffadki najednou nez vkladat jeden po druhém.

1) Vybereme pozadovany pocet sloupcli nebo fadki tim, Ze podrzime levé tlacitko mysi na
prvnim z nich a tAhneme pres jejich zahlavi.

2) Dale postupujeme stejné jako u vkladani jednoho sloupce nebo fadku popisovaného
vySe.
Skryvani a zobrazovani sloupct a fadkd
Skryti sloupcl nebo fadk:

1) Vybereme fadek nebo sloupec, ktery chceme skryt.
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2) V hlavni nabidce prejdeme do poloZzky Format a zvolime Radky nebo Sloupce.

3) Z podnabidky vybereme volbu Skryt. Mizeme také klepnout pravym tlac¢itkem mysi na
zahlavi fadku nebo sloupce a z mistni nabidky vybrat volbu Skryt fadky nebo Skryt
sloupce.

Zobrazeni skrytych sloupctll a fadku:

1) Vybereme rfadky nebo sloupce na kazdé strané skrytého fadku nebo sloupce.
2) V hlavni nabidce prejdeme do polozky Format a zvolime Radky nebo Sloupce.

3) Z podnabidky vybereme volbu Zobrazit. Mizeme také klepnout pravym tlacitkem mysi
na zahlavi fadku nebo sloupce a z mistni nabidky zvolit Zobrazit fadky nebo Zobrazit
sloupce.

Mazani sloupctli nebo radkd

1) Vybereme sloupce nebo fadky, které chceme smazat.

2) V hlavni nabidce zvolime List a vybereme Smazat fadky nebo Smazat sloupce nebo
klepneme pravym tlaCitkem mysi a z lokalni nabidky zvolime Smazat sloupce nebo
Smazat fadky.

Mazani bunék

1) Vybereme buriky, které chceme smazat.

2) Prejdeme do nabidky List > Smazat bunky nebo stiskneme Ctrl + -. Nebo klepneme
pravym tlacitkem mysi na bufiku a z mistni nabidky vybereme Smazat.

3) Vybereme pozadovanou volbu z dialogového okna Smazat buriky (obrazek 97)
a klepneme na OK.

Smazat buriky X

Vybér
® Posunout buriky nahoru:
) Posunout buriky doleva
) Smazat celé fadky

) Smazat celé sloupce

Napovéda QK Zrusit

Obréazek 97: Dialogové okno Smazat
buriky

Prace se seSity

Vkladani novych listl

Klepnutim na ikonu PFidat List (+), kterou najdeme vedle karet listd, pfidame novy za posledni
list v sesité bez otevieni dialogového okna VloZit list.

Nasledujicim zplsobem se otevira dialogové okno VloZit list (obrazek 98), ve kterém mizeme
urcit umisténi nového listu, vytvorit vice listd, zadat nazev nového listu nebo vybrat list ze
souboru.

* Vybereme list na misté, kam chceme vloZit novy list, a poté zvolime v hlavni nabidce List
> Vlozit list.
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* Klepneme pravym tlacitkem mysi na kartu, kam chceme vlozit novy list, a vybereme
v mistni nabidce Vlozit list.

« Klepneme v prazdném prostoru na konci karet listd.

« Klepneme pravym tlac¢itkem mysi do prazdného mista na konci karet listd a vybereme
v mistni nabidce Vlozit list.

VlIoZit list X

Umisténi

) Za aktualni list

List
® Novy list
Pocet listd: |1 =
Nazewv: Lists
i) Ze souboru
Prochazet...
Odkaz
Napovéda OK Zrudit

Obréazek 98: Dialogové okno VioZit list

Pfesouvani a kopirovani listd

Listy mdzeme v ramci téhoz seSitu pfesouvat nebo kopirovat pfetahovanim nebo pomoci
dialogového okna Presunout/kopirovat list. Chceme-li list pfesunout nebo zkopirovat do jiného
seSitu, je tfeba pouzit dialogové okno PFesunout/kopirovat list.

V dialogovém okné Presunout/kopirovat list (obrazek 99) mizeme presné urcit, jestli se ma list
presunout nebo zkopirovat do stejného, nebo jiného sesitu, kde mé byt v ramci seSitu umistén,
a jaky ma byt jeho nazev.

1) V aktualnim dokumentu klepneme pravym tlacitkem mysSi na kartu listu, ktery chceme
pfesunout nebo kopirovat, vybereme z mistni nabidky Pfesunout/kopirovat list nebo
zvolime v hlavni nabidce List > Pfesunout nebo kopirovat list.

2) V oblasti Cinnosti vybereme P¥esunout, pokud chceme list pfesunout, nebo Kopirovat,
pokud jej chceme zkopirovat.
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Presunout/kopirovat list

Cinnost
@ Presunout () Kopirovat
Umisténi

Do dokumentu

Strojovy park TTT (aktudlni dokument) |~

VloZit pred

Seznam strojul

Kategorie stroji
Kontrolni list

Karty strojd

- pfesunout na konec -

Novy nazev
Seznam strojd NOVY

MNapovéda QK Zrusit

Obréazek 99: Dialogové okno
Presunout/kopirovat list

3) Zrozbalovaciho seznamu Do dokumentu vybereme seSit, do kterého chceme list umistit.
MCUZe to byt stejny sesit, jiny jiZ otevieny, nebo novy.
4) V poli VioZit pred vybereme, kam chceme list umistit.

5) Pokud chceme pfi pfesouvani nebo kopirovani list piejmenovat, napiSeme nazev do
textového pole Novy nazev. Jestlize nezadame nazev, vytvorfi Calc vychozi nadzev (List 2,
List 3, atd.).

6) Klepnutim na tlagitko OK presun nebo kopirovani potvrdime a dialogové okno se zavre.

Upozornéni

Pokud presouvame nebo kopirujeme do jiného nebo nového sesitu, miiZe nastat
konflikt se vzorci odkazujicimi na jiné listy z plivodniho umisténi.

Skryvani a zobrazovani listi

Nékdy mlzeme chtit skryt obsah listu, abychom ochranili data proti nAhodnym zménam nebo
proto, Ze obsah listu neni nutné zobrazit.

Chceme-li skryt list nebo vice listll, vybereme list nebo listy (jak je uvedeno vyse), klepneme
pravym tlacitkem mysi, otevieme lokalni nabidku a vybereme Skryt list.

Chceme-li zobrazit skryté listy, klepneme pravym tlacitkem na kartu listu a zvolime v mistni
nabidce Zobrazit list. Zobrazi se dialogové okno se seznamem vSech skrytych listl. Vybereme
poZadované listy a klepneme na OK.

6 Tip

LibreOffice Calc neumoznuje skryt posledni viditelny list.
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Pfejmenovani listl

Vychozi nazev pfidaného listu je List X, kde X je Cislo pfidaného listu. Takové nazvy jsou vhodné
pro maly pocet listd, ale pfi velkych poctech jsou nepfehledné a je lepsi listy pojmenovat jinak.
Pro pfejmenovani listu pouzijeme jednu z téchto metod:

» Zadame nazev do textového pole Nazev pfi jeho vytvareni, pomoci dialogového okna
VloZit list (obrazek 98 na strané 153).

* Klepneme pravym tlacitkem mySi na kartu listu, v mistni nabidce zvolime Pfejmenovat
list a nahradime sou€asny nazev novym.

* Poklepeme na Kartu listu, ¢imz otevieme dialogové okno Pfejmenovat list.

Poznamka

Nazev listu musi za€inat pismenem nebo &islem, jiné znaky vCetné mezery nejsou
povoleny. Ostatni znaky mohou byt pismena, Cislice, mezera nebo podtrzitko. Pfi
pokusu o pfejmenovani na neplatny nadzev se zobrazi chybova zprava.

Mazani listu

Chceme-li smazat jeden list, klepneme pravym tlacitkem mysi na jeho kartu a zvolime z mistni
nabidky Smazat list nebo vybereme z hlavni nabidky List > Smazat list. Smazani potvrdime
klepnutim na tlagitko Ano.

Pokud chceme smazat vice listll, vybereme je (viz ,Vybér list(“ na strané 150), pak na jednu
z vybranych karet klepneme pravym tlacitkem mySi a z mistni nabidky zvolime Smazat list nebo
z hlavni nabidky zvolime List > Smazat list. Smazani potvrdime klepnutim na tlacitko Ano.

Prohlizeni seSitu

Zména zobrazeni dokumentu

Funkci priblizeni (Zobrazit > P¥iblizeni) pouZijeme pfi praci v sesSité pro zobrazeni vice nebo
méné bunék v okné. Vice informaci o priblizeni najdeme v kapitole 1—- Pfedstavujeme
LibreOffice.

Ukotveni radku a sloupci

Ukotveni se pouziva k uzaméeni fadkd v horni ¢asti listu nebo k uzaméeni sloupct v levé Casti
listu. Kdyz se potom pohybujeme v listé, ukotvené sloupce a fadky zlstavaji stale zobrazené.

Obrazek 100 zobrazuje ukotveneé fadky a sloupce. Na obrazku vidime siln&jsi vodorovnou ¢aru
mezi fadky 4 a 5 a svislou ¢aru mezi sloupci C a D, které vymezuji ukotvené oblasti. Radky 4 az
22 a sloupce G az P byly posunuty mimo stranku.

A B | C | o | £ | F Q | R
1 Datum | Hodnota prodeje Kategorie Region Zaméstnanec
2 02.01.2008 $410 Tenis Sever Kurt
3 02.01.2008 $1 508 Golf \f/ychod Hans
23 25.01.2008 $4 263 Tenis Sever Ute
24 26.01.2008 $2 811 Golf Jih Fritz

Obréazek 100: Ukotvené radky a sloupce

Prvni Fadek nebo sloupec €asto obsahuji zahlavi, které chceme mit viditelné pfi prochazeni
dlouhé nebo Siroké tabulky. Chceme-li rychle ukotvit fadky, sloupce nebo oboji, pouzijeme pro
ukotveni obojiho ikonu Ukotvit fFadky a sloupce na nastrojové listé Standardni, nebo pro
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ukotveni fadku Ci sloupce pfikazy z rozbalovaciho seznamu ikony Ukotvit Fadky a sloupce:

Ukotvit prvni fadek a Ukotvit prvni sloupec.
Ukotveni fadk( nebo sloupct (jednoho nebo vice):

1) Klepneme na z&hlavi fadku, nad ktery chceme vloZzit bod ukotveni nebo na zahlavi
sloupce, pred ktery chceme vlozit bod ukotveni.

2) Klepneme pravym tlacitkem mySi a vybereme Ukotvit Fadky a sloupce z mistni nabidky
nebo vybereme Zobrazit > Ukotvit fadky a sloupce v hlavni nabidce nebo klepneme na
ikonu Ukotvit fadky a sloupce, kterou najdeme na standardni nastrojové listé.

Ukotveni fadkl a sloupct (jednoho nebo vice): :

1) Klepneme na buriku, ktera mé byt tésné pod vodorovnym ukotvenim a zaroven tésné
pred svislym ukotvenim.

2) V hlavni nabidce vybereme Zobrazit > Ukotvit fadky a sloupce nebo klepneme na
ikonu Ukotvit Fadky a sloupce na standardni nastrojové listé.

Zruseni ukotveni

Chceme-li ukotveni fadkd a sloupct zrusit, mGzeme bud pouzit v hlavni nabidce volbu Zobrazit
> Ukotvit Fadky a sloupce, nebo mizeme klepnout na ikonu Ukotvit Fadky a sloupce na
standardni nastrojové listé. SilnéjSi Cary indikujici ukotveni zmizi.

Rozdéleni obrazovky

Druhy zpUsob, jak zménit zobrazeni listu, je rozdéleni obrazovky (pouziva se i pojem ,rozdéleni
okna“). Obrazovka se da rozdélit vodorovné, svisle nebo obéma zplsoby najednou. MdZeme tak
soucasné zobrazit az Ctyfi Casti seSitu. Priklad je zndzornén na obrazku 101, pfiCemz rozdéleni
je oznaCeno zvyraznénym okrajem bunék.

Tento zplisob se mize hodit napfiklad tehdy, kdyz mame v jedné ¢asti velkého listu buriku

s ¢islem pouzivanym tfemi vzorci v jinych burikdch. Pomoci rozdéleni obrazovky mdzeme umistit
bunku obsahuijici €islo do jedné &asti zobrazeni a buriky se vzorci do jinych ¢asti zobrazeni. Tato
moznost ndm umozfuje jednoduse sledovat, jaky vliv ma zmeéna Cisla v bufice na vysledky
vzorcU.

A | B | ¢ |
1 Beta= 3.2
2 Al= 01
_7 |Al= Beta*AD*(1*AD) 0.6421
_ 8 |A2= Beta*AL*(1*AD) 0.6582
_9 |A3= Beta*A0*(1*AD) 0.7219
_10 |Ad= Beta*A0*(1*AD) 0.6574
_11 |Ab= Beta*A0*(1*AD) 0.6597

12

Obrézek 101: Priklad rozdéleni obrazovky

Vodorovné nebo svislé rozdéleni obrazovky

Mame dva zpUsoby, jak rozdélit obrazovku vodorovné nebo svisle.
Zpusob 1

Rozdéleni bud vodorovné, nebo svisle:

1) Klepneme na zahlavi fadku, nad ktery chceme vloZit bod rozdéleni nebo na zahlavi
sloupce, pred ktery chceme vlozit bod rozdéleni.

2) Klepneme pravym tlaCitkem mySi a z lokalni nabidky vybereme Rozdélit okno nebo
v hlavni nabidce zvolime Zobrazit > Rozdélit okno. Mezi fadky a sloupci se zvyrazni
okraje bunék, oznacujici polohu rozdéleni (obrazek 101).
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Rozdéleni vodorovné a svisle souc¢asné:

1) Klepneme na buriku, ktera mé byt tésné pod vodorovnym a z&roven tésné za svislym
rozdélenim.

2) V hlavni nabidce vybereme Zobrazit > Rozdélit okno.
Zpusob 2

Chceme-li okno rozdélit vodorovné, uchopime mysi obdélnicek s vodorovnou ¢arkou, ktery se
nachéazi nad svislym posuvnikem (obrazek 102), a pretahneme jej pod fadek, pod kterym
chceme okno rozdélit.

Podobné pro vertikalni rozdéleni uchopime mysi obdélniek se svislou ¢arkou, ktery se nachazi
na pravé strané za vodorovnym posuvnikem, a pfetdhneme jej za sloupec, za kterym chceme
okno rozdélit.

-
b
H ~ » l\
[+ | 100 % \
Meranie ce: Horizontalni delici Vertikalni delici
pruh obrazovky pruh cbrazoviy

Obréazek 102: Rozd€&lené Casti obrazovky

Odebrani rozdéleni obrazovky
Rozdéleni obrazovky odebereme jednim z nasledujicich zplsob:
* Poklepeme na kazdou rozdélovaci ¢aru.
i

* Klepneme a pretahneme rozdélovaci Cary zpét na jejich vychozi pozice na koncich
posuvnikd.

* V hlavni nabidce zvolime Zobrazit a zruSime zaSkrtnuti poloZzky Rozdélit okno.

* Klepneme pravym tlacitkem mySi na zahlavi sloupce nebo fadku a v lokalni nabidce
zruSime oznaceni volby Rozdélit okno.

Vkladani dat pomoci klavesnice

VétSina dat jde do Calc zadat pomoci klavesnice.
Cisla

Klepneme na buriku a napiSeme cislo pomoci numerickych klaves v hlavni nebo v numerické
Casti klavesnice. Cisla jsou ve vychozim nastaveni zarovnana vpravo.

Zaporna cisla
Kdyz chceme zadat zaporné Cislo, bud napiSeme pred €islo znaménko minus (-), nebo Cislo
uzavieme do zavorky (), napfiklad (1234). Vysledek je v obou pfipadech stejny: —1234.

Uvodni nuly

Pokud Cislo zaddme s avodnimi nulami, napfiklad 01481, tyto nuly Calc ve vychozim nastaveni
odstrani. Pokud chceme zachovat minimalni pocet znak{ v burice pfi zadavani ¢isel a zaroven
zachovat formét danych Cisel, napfiklad 1234 a 0012, pouZijeme jednu z téchto metod pro
pridani nul na zacatek.
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Zplsob 1

1) Vybereme buriku a nasledné na ni bud' klepneme pravym tlac¢itkem mysi a v mistni
nabidce zvolime Format bunék, nebo v hlavni nabidce vybereme Format > Bunky,
nebo pouzijeme klavesovou zkratku Ctrl + 1. Ve vSech pfipadech se otevie dialogové
okno Formét bunék (obrazek 103).

2) Zvolime kartu Cisla a vybereme polozku Cislo v seznamu Kategorie.

3) Do pole u polozky Uvodni nuly v €asti MoZnosti zadame minimalni pocet tvodnich nul.
Pokud pozadujeme napfiklad minimalné Ctyfi znaky, zadame 4. Kazdé Cislo mensi nez
Ctyfi znaky bude mit pfidané tGvodni nuly, napfiklad z Cisla 12 se stane 0012.

4) Potvrdime je stisknutim tladitka OK. Cislo si v3ak interné zachova sviij b&zny format a tak

ho bude program vyhodnocovat, pokud bude pouzito jako argument ve funkcich nebo
vzorcich.

Format bunék

Cisla Pismo Efekty pro pismo Zarovnani Ohraniceni Pozadi Ochrana buriky

Kategorie Format Jazyk
Vee Vichozi - Cestina E
Definované uZivatelem -1235
Cislo | |-1234,57
Procento -1235
Ména -123457
Datum -123457
Cas
Védecky
Zlomek
Booleovska hodnota
Text -1234,56789012346
Moznosti

Desetinna mista: = | OZapoma &isla éervend

Uvodni nuly: |1 = 0 Oddélovac tisict

Formatovaci kad

Standard

Obréazek 103: Dialogové okno formatovani bunék — karta Cisla
Zpusob 2
1) Vybereme bunku.

2) V postranni listé pfejdeme na kartu Vlastnosti. Pokud je potfeba, klepneme na ikonu
Otevrit panel (+ nebo Sipka) panelu Format Cisla, abychom zobrazili moznosti tohoto
panelu (obrazek 104).

3) V rozeviracim seznamu vybereme Cislo nastavime hodnotu pole Uvodni nuly na 4.
Zmeéna formatovani se projevi okamzité.
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-~ Format €isla F

Obecny v| @ % 00
Desetinna mista: Uvodni nuly:

w 1 w
[ Zaporna cisla cerveng
[] Oddélovac tisicl

Obréazek 104: Nastaveni uvodnich nul
v postranni listé

@ ip
Abychom naformatovali Cisla tak, aby zobrazovala pouze desetinna mista bez
Gvodnich nul (napfiklad 019 misto 0,019), pak v poli Formatovaci kéd (obrazek 103)
zapiSeme. (tecka) nasledovana ? (otazniky) znacicimi pocet potfebnych desetinnych

mist. Napfiklad pro 3 desetinnd mista zadame .??7? a klepneme na OK. Jakékoliv
Cislo, které bude mit pouze desetinna mista, nebude uvozeno nulami.

@ Tip
Pokud Ciselné znaky nemuseji byt ve vypoctech povazovany za Cisla (napfiklad kdyz
zadavame postovni smérovaci ¢islo), miiZzeme napsat pred ¢islo apostrof ('),

napriklad '01481. Kdyz pfesuneme zaméreni buriky, apostrof je odstranén, uvozujici
nuly jsou zachovany a Cislo je pfevedeno na text zarovnany vlevo.

Cisla a text
Cisla miZzeme jako text zadat jednim z néasledujicich zptsob(:
Zpulsob 1

1) Vybereme bunku a nasledné na ni bud klepneme pravym tlac¢itkem mySi a v mistni
nabidce zvolime Format bunék, nebo v hlavni nabidce vybereme Format > Bunky,
nebo pouZijeme klavesovou zkratku Ctrl + 1. Ve vSech pfipadech se otevie dialogové
okno Forméat bunék (obrazek 103).

2) Ujistime se, Ze je vybrana karta Cisla, poté vybereme Text ze seznamu Kategorie.

3) Potvrdime je stisknutim tla¢itka OK. Cislo je pfevedeno do textové podoby a je, podle
vychoziho nastaveni, zarovnané doleva.

Zptlsob 2
1) Vybereme buriku.

2) V postranni listé pfejdeme na kartu Vlastnosti. Pokud je potfeba, klepneme na ikonu
Otevrit panel (+ nebo Sipka) panelu Format ¢isla, abychom zobrazili moznosti tohoto
panelu (obrazek 104).

3) Vybereme Text v rozbalovacim seznamu Kategorie. Zména formatovani se projevi
okamzité.
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Poznamka

Ve vychozim nastaveni Cisla, ktera byla pfevedena na text, budou ve vSech vzorcich
seSitu vyhodnocena jako nula. Funkce ve vzorcich textové polozky ignoruji. Tuto
funkci mlZzeme zménit v Nastroje > MozZnosti > LibreOffice Calc > Vzorec.

V poloZce Podrobné nastaveni vypocti vybereme Vlastni (pfevod textu na éisla

a dalsi). Klepneme na tlacitko Podrobnosti a zvolime odpovidajici nastaveni

v zobrazeném dialogovém okné (rozbalovaci seznam Prevod textu na ¢islo).

Text

Klepneme na buriku a napiSeme text. Text je ve vychozim nastaveni zarovnan vievo. Buriky
mohou obsahovat nékolik fadkd textu. Pokud chceme vytvofit odstavce, stiskneme pro vytvoreni
nového odstavce Ctrl + Enter.

Zadavame-li nékolik fadkl textu na radku vzorcl, mlZzeme prodlouzit vstupni Fadek. Klepnutim

na ikonu RozsiFit vstupni fadku umisténou na pravé strané radku vzorcl se vstupni Fadek
stane vicefadkovym.

Datum a cas

Vybereme bunku a zadame datum nebo ¢as. Jednotlivé ¢asti datumu je mozné oddélovat teckou
(10.10.2020 nebo 10.10.20), spojovnikem (pouze 10-10) nebo Ize pouzit text (10. fijen 2020).
Formét data se po zadani automaticky zméni na nastaveny vychozi format.

Pokud vkladame €as, oddélujeme ho dvojteckou (13:45 nebo 13:45:20). Forméat Casu se po
zadani automaticky zmeéni na nastaveny vychozi forméat.

Zména formatu data a €asu, ktery Calc pouziva:

1) Vybereme buiku a otevieme dialogové okno Formét bunék (obrazek 103).

2) Uijistime se, Ze je vybrana karta ¢isla, poté vybereme datum nebo €as ze seznamu
Kategorie.

3) Pozadovany format zvolime v seznamu Format. Klepneme na OK.

Pole v bunkéach
Do buiiky mGzeme vlozit pole spojené s datem, ndzvem listu nebo ndzvem dokumentu.

1) Vybereme buriky a dvojklikem aktivujeme editacni mod.

2) Klepneme pravym tlacitkem mySi a vybereme VloZit pole > Datum, Nazev listu nebo
Nazev dokumentu v mistni nabidce.

Nad t&mito tfemi moZnostmi jsou dal$i tlagitka Datum a Cas, kterd vloZi stejné informace, ale
nebudou se aktualizovat ani pfepocitavat jako vySe uvedené moZznosti.

Poznamka

Pfikaz VloZit pole > Nazev dokumentu vloZi nazev sesitu, nikoliv nazev definovany
v dialogu Vlastnosti souboru na karté Popis.

@ Tip
Pole jsou aktualizovana ve chvili, kdy dojde k ulozeni seSitu nebo kdyz pouzijeme
klavesovou zkratku Ctrl+Shift+F9.
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Automatické opravy

Calc béhem zadavani dat provadi mnoho automatickych oprav, pokud je nevypneme. VeSkeré
zmény automatickych oprav mizeme také vratit zpét pomoci klavesové zkratky Ctrl + Z anebo
ru€né prostym prepsanim opravy.

Chceme-Ili zménit MozZnosti automatickych oprav, pfejdeme na Nastroje> MoZnosti
automatickych oprav na panelu nabidek otevieme dialogové okno Automatické opravy
(obrazek 105).

Karta Nahradit
Umoziuje upravit tabulku nahrad pro automatické opravy nebo nahrazovani slov i
zkratek.

Karta Vyjimky
Specifikujeme zkratky nebo kombinace pismen, které se nemaji opravovat automaticky.

Karta MoZnosti
Zvolime mozZnosti pro funkci automatické opravy chyb pfi psani.

Karta Mistni moznosti
Nastavi v automatickych opravach znaky pro uvozovky a moznosti, které jsou specifické
pro dany jazyk textu.

Tlacitko Obnovit
Obnoveni zménénych hodnot zpét na pfedchozi hodnoty.

Vypnuti automatickych oprav

Nékteré opravy se pfi zadavani textu pouZziji az po stisknuti mezerniku. Pokud chceme
automatické opravy vypnout, resp. zapnout, zvolime v hlavni nabidce Nastroje a zruSime
zaSkrtnuti, resp. zaSkrtneme, volbu Automatické dokon€ovani. Viz také ,Nastroje
automatického dokoncovani“ nize.

Automatické opravy

Nahrady a wjjimky pro jazyk: |Cestina ~
Nahradit Vyjimky MoZnosti Mistni moZnosti
Nahradit Za
-- - Pouze text
R | | o
—_— _—
- - Smazat
b {
h )
o +
= - v
MNapovéda QObnovit OK Zrusdit

Obréazek 105: Dialogové okno Automatické opravy

Urychleni vkladani dat

Zadavani dat do listu mlze byt velmi pracné, Calc vSak poskytuje nékolik nastrojd, které praci
usnadniuji.
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Zéakladni moznosti je pfetaZzeni obsahu jedné buriky do druhé pomoci mySi. Mnozi uZivatelé
povazuiji za uzitecnou funkci Automatické doplriovani. Calc také obsahuje nékolik dalSich
nastrojll pro automatizaci vstupu, zejména pro opakujici se data. Patfi mezi né nastroj Vyplnit,
seznamy vybéru a moznost zadavat data do vice listll stejného sesitu.

Nastroje automatického dokoncéovani

Nastroj Automatického dokoncovani v programu Calc automaticky dokonc€uje zaznamy podle
zdznamuU ve stejném sloupci. KdyZ je text v burice zvyraznén, lze automatické dokoncovani
pouzit nasledovné:

1) Pokud chceme pfijmout navrzené dokong&eni, stiskneme Enter, F2 nebo klepneme mysi.

2) Pokud chceme vidét vice navrhli pro dokonéeni, pouZijeme kombinaci klaves Ctrl + Tab
pro posun vpfed nebo Ctrl + Shift + Tab pro posun zpét.

3) Chceme-li zobrazit seznam vSech dostupnych textl pro automatické dokoncovani
v aktualnim sloupci, stiskneme kombinaci klaves Alt + Sipka dold.

Pokud zadavame vzorce a pouzivame znaky, které odpovidaji dfive zadanym polozkam, zobrazi
se tip napovédy se seznamem deseti naposledy pouzitych funkci z Priivodce funkci, ze vSech
pojmenovanych oblasti a z obsahu pojmenovanych oblasti. Automatické dokon€ovani ignoruje
pfi zadavani dat velikost pismen.

Ve vychozim nastaveni v programu Calc je funkce automatické dokoncovani aktivovana.
Chceme-li ji vypnout, pfejdeme v hlavni nabidce na Nastroje a zruSime vybér Automatické
dokon€ovani.

Nastroj Vyplnit

Nastroj Vyplnit se pouZiva ke kopirovani jiz existujiciho obsahu nebo k vytvofeni datové
posloupnosti na vybrané oblasti bunék (viz obrdzek 106).

1) Vybereme buriku, jejiz obsah chceme kopirovat nebo ze které chceme vytvofit
posloupnost.

2) Tazenim mysi se stisknutym tlacitkem nebo klepnutim na posledni buniku vybéru se
stisknutou klavesou Shift zvolime oblast, kterou chceme vyplnit.

3) Zvolime v hlavni nabidce List > Vyplnit buiiky a vybereme v podnabidce smér pro
kopirovani nebo vytvoreni dat (Vyplnit nahoru, Vyplnit dold, Vyplnit vievo nebo
Vyplnit vpravo), Vyplnit posloupnost nebo Vyplnit nahodnymi €isly.

DalSi moznosti je pouzit klavesovou zkratku.

1) Vybereme buriku, jejiz obsah chceme kopirovat nebo ze které chceme vytvofit
posloupnost.

2) Prfesuneme kurzor nad ¢tverecek v pravém dolnim rohu buriky. Kurzor zmeéni tvar.

3) Stiskneme levé tlaCitko mysi a kurzor potahneme smérem, ve kterém chceme buriky
vyplnit. Pokud burika obsahuje text, buriky se v daném sméru vyplni stejnym textem.
Pokud bunka obsahuje €islo, buriky se vyplni posloupnosti Cisel.
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1 Vyplnéni 1 Vyplnéni posloupnosti
W Original 2 | 245678
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4 Original 4 245680
5 Original 5 245681
(3 Original 6 245682
7 Original 7 245683
8 Original 8 245684

Obréazek 106: PouZiti nastroje Vyplnit

Vyplnovani posloupnosti dat

Pokud zvolime List > Vyplnit bunky > Vyplnit posloupnost, otevie se dialogové okno Vyplnit
posloupnost (obrazek 107). V ném mudZeme zvolit poZzadovany typ posloupnosti.

Vyplnit posloupnost

Typ posloupnosti Jednotka casu
® Linearni Den
O Rist Den v tydnu
(2 Datum Mésic
2 Automatické vyplnéni Rok

Pocatecni hodnota:
Koncova hodnota:

Prirdstek: 1

Napovéda oK Zrusit

Obrazek 107: Dialogové okno Vyplnit posloupnost

Definovani posloupnosti

Pokud oznacime moznost Automatické vyplnéni v dialogovém okné Vyplnit posloupnost,
zadame text do pole Pocatec¢ni hodnota a klepneme na OK. Calc provede kontrolu, jestli néktery
z pfeddefinovanych Razenych seznami neobsahuje zadany text. Pokud existuje fazeny seznam
obsahujici zadany text, Calc jej pouzije a vyplni timto fazenym seznamem buriky. V hlavni
nabidce zvolime Nastroje > MoZnosti > LibreOffice Calc > Razené seznamy, ¢imZ zobrazime
nase aktualné definované fazené seznamy.

Chceme-li definovat vlastni fazeny seznam, ktery budeme pozdéji pouzivat pro vyplhovani
posloupnosti:

1) V hlavni nabidce zvolime Nastroje > MoZnosti > LibreOffice Calc > Razené seznamy,
¢imz otevieme dialogové okno Razené seznamy (obrazek 108). V tomto okné se v poli
Seznamy zobrazuiji jiz definované seznamy, v poli PoloZky pak vidime jednotlivé prvky
vybraného seznamu.

2) Klepneme na tlacitko Novy, ¢imz se PoloZky vycisti.

3) Polozky nového seznamu napiSeme do pole PoloZky (jednu do kazdého fadku).
4) Klepneme na tlaCitko PFidat, ¢imZ se novy seznam objevi v poli Seznamy.

5) Klepnutim na tlagitko OK novy seznam uloZime.
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Moznosti - LibreOffice Calc - Razené seznamy

&

LibreOffice Seznamy PoloZky

Nowy
Maéitani/ukladani Novy

&

po,ut,st,ctpa,so,ne po

J:r_xzykova_ nastaven pondéli,(tery stfeda,ctvrtek,patek,sobot; ut Piidat
LibreOffice Calc LILILIVVVEVILVITLIX XXX st
Obecne leden,unor,bfezen,dubenkvéten,cerven, ct Smazat

O =

Vychozi nastaveni
Zobrazeni
Vypocty

Vzorec

7873

Razené seznamy
Zmény
Kompatibilita
MriZka
Tisk

LibreOffice Base

Grafy

Internet < >

Kopirovat seznam z:  §'Karty strojd".$E$11:$E528 Kopirovat

Napovéda Obnovit PouZit QK Zrusit

Obrézek 108: Dialogové okno Razené seznamy

Seznamy pro vybér

Seznamy vybéru jsou dostupné pouze pro text a jejich pouZziti je omezeno jen na text, ktery jiz byl
zadan do stejného sloupce.
1) Vybereme buriku ve sloupci nebo rfadku, ktery obsahuje burky s textovymi poloZzkami.

2) Klepneme pravym tlacitkem mySi a zvolime z mistni nabidky Seznam vybéru nebo
stiskneme Alt + Sipka dol(l. Otevie se rozbalovaci seznam, ve kterém se nachazeji
vSechny textové polozky z daného sloupce.

3) Klepneme na pozadovanou polozku, ktera se nasledné vlozi do buriky.

Sdileni obsahu meazi listy

Stejny (daj je mozné vloZit najednou do stejné buriky ve vice listech seSitu, napfiklad tehdy, kdyz
chceme ve v3ech listech vytvorit stejny seznam jednotlivel nebo organizaci. Nemusime tedy
seznam vkladat jednotlivé na kazdy list, mGZeme ho najednou vloZit do vSech listd.

1) V hlavni nabidce zvolime Upravy > Vybrat > Vybrat listy, ¢imZ otevieme dialogové okno
Vybrat listy.

2) V ném vybereme jednotlivé listy, do kterych chceme data vlozit.
3) Vybér potvrdime klepnutim na tladitko OK, karty listl pfitom zméni barvu.
4) Udaje zadame do bunék prvniho z vybranych list(, pfitom se vloZi i do v3ech ostatnich.
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Upozornéni

Tato metoda bez upozornéni pfepiSe vSechny Udaje, které jiz jsou v pfisluSnych
burikach na ostatnich vybranych listech. Po vloZeni spole¢nych dat proto nesmime
zapomenout vybér listll zrusit, aby se dal$i zadavana data vkladala jen do jednoho
listu.

Ovérovani obsahu bunék

Pfi vytvareni sesitd, které budou pouzivat jini lidé, mizeme chtit zajistit, aby jimi zadavana data
byla platna a aby byla zadavana do spravnych bunék. Ovéreni platnosti mlizeme pouzit i pro
svou vlastni praci jako pomdcku pfi zadavani slozitych nebo méné ¢asto pouzivanych dat.

Posloupnost a Seznamy vybéru umoZziiuji zpracovat ur€ité typy dat, které jsou omezeny na
preddefinované informace. Chceme-li ovéfovat nova data zadavana uzivatelem, vybereme bunku
a v hlavni nabidce zvolime Data > Platnost, kde stanovime typ obsahu, ktery mdze byt do burky
zadan. Bunika mize napriklad vyZzadovat datum, celé &islo bez pismen &i desetinné ¢arky, nebo
Ze nesmi zUstat prazdna.

Podle toho, jakou platnost nastavime, miZzeme také definovat rozsah obsahu, ktery mlize byt
zadan. MGzeme také nechat zobrazit napovédu, ktera vysvétli nastavena pravidla a to, co by
méli uzivatelé délat, kdyzZ je obsah buriky neplatny. Mizeme také nastavit buriku tak, aby
neplatny obsah odmitla, pfijala ho s upozornénim, nebo pfi ném spustila makro. Vice informaci
se nachazi v kapitole 2, Zadavani, Uprava a forméatovani dat v pfirucce Calc.

Uprava dat

Mazani dat

Mazani pouze dat

Pokud chceme smazat pouze data v burice nebo oblasti bunék a nechceme smazat format
bunky, vybereme buriky a stiskneme klavesu Delete.

Pokud chceme UpIné smazat buriky, sloupce nebo fadky, vice informaci najdeme na strané 152.

Mazani dat a formatovani
Data a formatovani se daji z bunky smazat soucasné. Provedeme to nasledovné:
1) Oznacime buriku nebo oblast bunék.

2) Stiskneme klavesu Backspace nebo klepneme pravym tlacitkem na burku a v mistni
nabidce vybereme Vymazat obsah nebo v hlavni nabidce zvolime List > Vymazat
bunky.

3) V dialogovém okné Smazat obsah (obrazek 109) vybereme nékterou z moznosti nebo
zvolime Smazat vse.

4) Potvrdime je stisknutim tlaCitka OK.
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Smazat obsah x

Vybér
[JSmazat vse
Text Cisla
Datum a ¢as Vzorce
[] Komentare L] Formaty
(] Objekty

Obrazek 109: Dialogové okno Smazat obsah

Nahrazovani dat

Chceme-li odstranit stavajici data a vlozit nova, vybereme buriku a nova data zadame. Plvodni
data burnky budou nahrazena novymi daty, plivodni formatovani se vSak zachova.

Druhou mozZnosti je vybrat buriku klepnout na vstupni radek na panelu vzorcll (obrazek 86 na
strané 141), nasledné poklepanim na obsah, aby se cely vybral, a zadat nové udaje.

Zména dat

Nékdy je tfeba zménit obsah buriky, aniz by se cely odstranil. Napfiklad zménu textu ,Prodej ve
2. kvartalu“ na text ,NarUst prodeje v kvartalu miiZzeme provést takto:

Pomoci klavesnice

1)

2)

3)

Jestlize pouzivame radgji klavesnici pro zménu dat v burikach s minimalnim pouzivanim
mysi, pak si zapneme volbu Nastroje > Moznosti > LibreOffice Calc > Obecné > Stisk
klavesy Enter pfepne reZim tprav. Tato zména zpUsobi, Ze kdykoliv klepneme na
buriku, abychom ji vybrali, pfepne se bufika automaticky do rezimu Gprav. DalSi moZnosti
je stisknout klavesu F2, abychom prepnuli buriku do rezimu Uprav.

Pouzijeme kurzorové Sipky, abychom si kurzor nastavili na misto, kam chceme zadavat
v burfice nova data. Potom stiskneme klavesu Delete nebo Backspace, abychom smazali
nechténa data, nez budeme zadavat data nova.

Po dokonceni Uprav stiskneme klavesu Enter, ¢imz ulozime zmény.

Pomoci mysi

1)

2)

3)

Poklepeme na bufiku, ¢imz ji vybereme a umistime do ni kurzor. MUGzeme také v hlavni
nabidce zvolit Upravy > ReZim upravy burky a pfepneme buiiku do reZzimu Gprav.

Provedeme jednu z nasledujicich moznosti:
* Kurzor pfemistime v burice tam, kam chceme zacit zadavat nova data.

« Klepnutim vybereme buriku a poté presuneme kurzor na vstupni fadek na listé vzorct
a klepneme na misto, kde chceme zacit upravovat data v burice.

Po ukonceni Uprav klepneme na jinou burku, ¢imZ se zmény uloZi.

Funkce VioZit jinak
Pokud chceme kopirovat text, Cisla nebo vzorce do cilové buriky nebo oblasti bunék:

1)

2)

Vybereme zdrojovou buriku nebo oblast bunék a zmacknutim Ctrl + C nebo pomoci
Upravy > Kopirovat zkopirujeme data.

Vybereme cilovou buriku nebo oblast bunék.
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3)

Na cilovou buiiku nebo oblast bunék klepneme pravym tlacitkem mysi, vybereme VloZit
jinak z mistni nabidky a zvolime pfikaz Neformatovany text, Text, Cislo nebo Vzorec.

Nebo mdzeme pouZit polozku z hlavni nabidky Upravy > VloZit jinak.

MUGzZeme také pouzit funkci VloZit jinak pro vlioZeni do jiné buriky vybrané ¢asti dat z plvodni
bunky nebo oblasti bunék, napf. format dat nebo vysledek vzorce. Provedeme to nasledovné:

1)
2)

3)
4)

5)
6)

Vybereme buriku nebo oblast bunék.

V hlavni nabidce zvolime Upravy > Kopirovat nebo stiskneme Ctrl + C nebo klepneme
pravym tlaCitkem mysSi a vybereme pfikaz Kopirovat z mistni nabidky.

Vybereme cilovou buriku nebo oblast bunék.

V hlavni nabidce zvolime Upravy > VloZit jinak > VloZit jinak nebo pouZijeme
klavesovou zkratku Ctrl + Shift + V nebo klepneme pravym tlacitkem mySi a vybereme
Vlozit jinak > Vlozit jinak z mistni nabidky. Ve vSech pfipadech se otevre dialogové
okno Vlozit jinak (obrazek 110).

Vybereme moznost pro Operace vybrat, MoZnosti, a Posunout buriky.

Klikneme na OK k vloZeni dat do cilové burky nebo rozsahu bunék a dialogové okno
zavieme.

VioZit jinak

Vybér Operace
s
) Pridat
) Odecist
Datum a ¢as ) Nasobit
[ Vzorce ) Délit
L] Komentére
L] Formaty
[ Objekty
MoZnosti Posunout bufiky

[ Pfeskocit prazdné bufiky @ Neposouvat
L] Transponovat ) Dol

L] Odkaz Z) Vpravo
Obréazek 110: Dialogové okno VloZit jinak

Formatovani dat

./ Poznamka

V8echna nastaveni popsand v této Casti Ize také nastavit jako soucast stylu buriky.
Vice informaci se nachazi v kapitole 4, Pouziti stylll a Sablon v pfiruc¢ce Calc.
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Viceradkovy text
Vice radku Ize zadat do jedné buriky bud automatickym, nebo ruénim zalomenim. Kazda
Z metod je vhodna pro jiné situace.
Automatické zalamovani
Pokud chceme vicefadkovy text v buiice zalomit automaticky, mdzeme pouzit nasledujici
zpUlsoby:
Zplsob 1
1) Klepneme pravym tlaCitkem mysi na buriku a v mistni nabidce zvolime Format bunék,
¢imz otevieme dialogové okno Forméat bunék.

2) Na karté Zarovnani (obrazek 111) v ¢éasti Vlastnosti vybereme Automaticky zalomit text
a klikneme na tlacitko OK.

Format bunék

Cisla Pismo Efekty pro pismo Zarovnani Ohraniceni Pozadi Ochrana buriky

Zarovnani textu

Vodorovneé; Qdsazeni: |0 pt =
Orientace textu
[ Svisle zarovnané
R B
™ r

Stupné: 0° -
Zakladna: [Z] ol O

Vlastnosti
[ Automaticky zalomit text
Déleni slov aktivni

1 Zmensit podle velikosti buriky

Smeér textu: |PouZit nastaveni nadrazeného objektu| ~

MNapovéda Obnovit OK Zrusit

Obréazek 111: Dialogové okno Format bunék — karta Zarovnani

Zpusob 2
1) Vybereme bunku.
2) Na karté Vlastnosti v postranni listé otevieme panel Zarovnani (obrazek 112).
3) Zaskrtneme moznost Zalomit text, zména se projevi okamzité.
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~ Zarovnani F]

il
i
il
111
|
3le
e

Odsazeni: 3= =

0 pt =

Orientace textu: |0° e IE 4|10

[ Svisle zarovnané

Obrazek 112: Zalomeni textu

Rucéni zalomeni textu

Pro vlozZeni ru€ni zalomeni fadky béhem psani, zmackneme Ctrl + Enter. Kdyz text upravujeme,
nejprve na bunku poklepeme a pak kurzor umistime tam, kde chceme fadek zalomit. Ve
Vstupnim fadku na Panelu vzorct mGzeme také stisknout Shift + Enter.

w7y

Kdyz text v bunice zalomime rucné, zméni se vySka radku, ale Sitka buriky se nezméni a text
mUlZe presahovat pres jeji okraj. Sitku buriky musime zménit ruéné nebo premistit zalomeni
fadku.

ZmensSeni textu podle velikosti buriky

Velikost pisma textu v burice Ize automaticky pfizpUsobit velikosti buriky. Chceme-li to provést,
zaSkrtneme moznost Zmensit podle velikosti bunky v oddile Viastnosti na karté Zarovnani
v dialogovém okné Format bunék (obrazek 111).

Slou€eni bunék
Sousedici buriky mdZzeme vybrat a sloucit je do jedné takto:

1) Vybereme oblast sousedicich bunék, které chceme sloucit.

2) Klepneme pravym tlacitkem mysi na vybrané burky a z mistni nabidky zvolime Slou¢it
burnky nebo v hlavni nabidce zvolime Format > Sloucit bunky > Sloucit buniky nebo
Sloucit bunky a zarovnat na stfed nebo klepneme na ikonu Slou€it bunky a zarovnat
na stfed na nastrojoveé listé Forméatovani. Pomoci Slou€it buriky a zarovnat na stied
bude obsah v burikach zarovnan na stfed.

3) Pokud burky obsahuji néjaka data, otevie se maly dialog (obrazek 113) a zobrazi
moznosti pro pfesun nebo skryti dat ve skrytych burikach. Vybereme si a klepneme na
OK.
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Sloucit buriky *

MNékteré bunky nejsou prazdné.

() Pfesunout obsah skrytych bunék do prvni buriky
(12 ]—[1 2|

® Zachovat obsah skrytych bunék:
(12 ]—[1 2]

(O Odstranit obsah skrytych bunék
(12 ]—[1 %]

Napovéda QK Zrusit

Obréazek 113: Volby slouc¢eni pro neprazdné
bunky

Upozornéni

Slouceni bunék miZe zpUsobit chyby vypoétu ve vzorcich v tabulce.

Rozdélovani bunék
Rozdélit mizeme pouze buriky, které vznikly slou¢enim nékolika bunék.

1) Vybereme slou€enou buriku.

2) V hlavni nabidce zvolime Format > Sloucit buriky > Rozdélit bufiky nebo klepneme
pravym tlacitkem mysi a z mistni nabidky vybereme Rozdélit bunky nebo klepneme na
ikonu Slou€it bunky a zarovnat na stfed na nastrojové listé Formatovani.

3) Data, kterd jsou v burice, zlstanou v prvni burice. Pokud skryté buriky mély pred
slou¢enim néjaky obsah, pak musime manualné obsah pfesunout do odpovidajicich
bunék.

s s

Formatovani Cisel

K formatovani bunék mdzeme pouzit nékolik typd formatl ¢isel dostupnych prostfednictvim ikon
na nastrojové listé Forméatovani. Vybereme bufku a pak klepnutim na pfislusnou ikonu zménime
formét Cisla.

Vice moznosti a dalsi formaty ¢isel mizeme nastavit na karté Cisla v dialogovém okné& Formét
bunék (obrazek 103 na strané 158):

« K forméatovani dat mdzeme pouzit kterykoliv typ dat ze seznamu Kategorie.

« V Gasti MoZnosti miZeme nastavit pocet desetinnych mist a Gvodnich nul.

« Mulzeme zadat vlastni formatovaci kéd.

« V oddile Jazyk mizeme zohlednit mistni nastaveni pro rlizné formaty, jako napfiklad
format data Ci symbol mény.

Neékolik formatl Cisla je k dispozici také na postranni listé v panelu Format &isla na karté
Vlastnosti. Pokud klepneme na tlaCitko DalSi moZnosti, otevie se dialogové okno Forméat bunék.
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Formatovani pisma a textu v burikach

6 Tip

Pro zachovani konzistence v tabulce pouzivejme styly bunék, kdykoliv je to mozné.

Pokud chceme manualné vybrat pismo a format textu pro pouZiti v burice:

1) Vybereme buriku nebo oblast bunék.

2) Klepneme na maly trojuhelnik vpravo vedle pole Nazev pisma na nastrojové listé
Formatovani a v rozbalovacim seznamu zvolime nové pismo nebo pouzijeme pole Nazev
pisma na panelu Znak na karté Vlastnosti v postranni li5té.

3) Klepneme na maly trojuhelnik vpravo vedle pole Velikost pisma na nastrojové listé
Formétovani a v rozbalovacim seznamu zvolime velikost pisma nebo pouZijeme pole
Velikost pisma na panelu Znak na karté Vlastnosti v postranni listé.

4) Dalsi zplsoby formatovani pisma mizeme nastavit pomoci tlacitek Tuéné, Kurziva
a Podtrzené, které najdeme na nastrojové listé Formatovani, nebo na panelu Znak na
karté Vlastnosti v postranni listé. V postrannim panelu je mozné zmeénit vzhled podtrzeni
a pridat k pismu nékteré dalSi efekty, napfiklad PfeSkrtnuti a Stin.

5) Pokud chceme zménit vodorovné zarovnani odstavce, klepneme na jedno ze Ctyf tlacCitek
pro zarovnani (Zarovnat vievo, Zarovnat na stied, Zarovnat vpravo, Do bloku), které
najdeme bud na nastrojové listé Formatovani, nebo na panelu Zarovnani na karté
Vlastnosti v postranni liSté. Pro vice moZnosti zvolime v hlavnim menu Format > Buiky
> Zarovnani a vybereme si jednu z moznosti v rozbalovacim seznamu Vodorovné.

6) Pokud chceme zmeénit svislé zarovnani textu v burice, zvolime v hlavni nabidce Format >
Bunky > Zarovnani a vybereme si jednu z moznosti v rozbalovacim seznamu Svislé.

7) Pokud chceme zménit barvu pisma, klepneme na Sipku vedle ikony Barva pisma na
nastrojové listé Formatovani nebo na panelu Znak na karté Vlastnosti v postranni li5té,
¢imz zobrazime paletu barev a z ni zvolime pozadovanou barvu.

8) Pokud chceme urcit jazyk burky, pouzijeme v dialogovém okné Formatu bunék kartu
Pismo.

9) Dalsi vlastnosti pisma mdzeme nastavit na karté Efekty pro pismo v dialogovém okné
Formét bunék.

Formatovani ohranic¢eni bunék

Kdyz chceme burice nebo skupiné vybranych bunék nastavit ohrani¢eni, klepneme na ikonu
Ohrani€eni na nastrojové listé Formatovani a zvolime jednu z moznosti zobrazenych v paleté.

Pokud chceme upravit styl ohranieni, klepneme na ikonu Styl ohrani€eni na nastrojové listé
Formétovani a vybereme styl Cary ze zobrazené palety. Pokud chceme upravit barvu ohraniceni,
klepneme na Sipku na pravé strané ikony Barva ohrani€eni na nastrojové listé Formatovani

a vybereme barvu €ary ze zobrazené palety.

Také panel postranni liSty Vzhled burky na karté Vlastnosti obsahuje ovladaci prvky Ohrani¢eni
bunky, Styl ¢ary a Barva Cary.

Pro vétSi kontrolu, v€etné odstupu mezi okraji bunék a daty v burice, pouZijeme kartu Ohrani¢eni
dialogového okna Format bunék, kde Ize také definovat styl stinovani. Klepnutim na tlaitko
DalSi moznosti na panelu Vzhled burky nebo klepnutim na volbu Dal$§i moZnosti v rozeviracim
seznamu styld ¢ar otevieme dialogové okno Format buriky na karté Ohraniceni.

Vice informaci se nachazi v kapitole 4, PouZiti styld a Sablon v pfirucce Calc.
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4/ Poznamka

Vlastnosti ohraniceni bunék se aplikuji pouze na vybrané burky a daji se zménit
pouze jejich Upravou. Pokud mé napfiklad burika C3 horni ohraniCeni, je mozné jej
odstranit pouze pfi zvoleni buniky C3. P¥i vybrani buriky C2 se odstranit neda,
prestozZe je opticky shodné s dolnim ohrani¢enim buriky C2.

Formatovani pozadi bunky

Pokud chceme nastavit barvu pozadi bufiky nebo skupiny bunék, klepneme na malou Sipku
vedle ikony Barva pozadi na nastrojové liSté Formatovani. Zobrazi se paleta s vybérem barev,
podobna paleté Barva pisma. Mzeme také pouzit kartu Pozadi v dialogovém okné Format
bunék. Panel Vzhled buriky na karté Vlastnosti postranni liSty obsahuje Pozadi buriky s paletou
barev. Vice informaci se nachazi v kapitole 4, PouZiti styld a Sablon v pfirucce Calc.

Formatovani vychoziho stylu burnky

Pokud chceme burice nebo skupiné bunék pfifadit vychozi styl, klepneme v hlavni nabidce na
Styly a zobrazi se nabidka vychozich styld. Vychozi styly mohou byt pouZity nebo upravovany
pomoci karty Styly v postranni listé. UzZivatelské styly buriky mliZzeme vytvaret tak, Ze klepneme
v hlavni nabidce na Styly > Novy styl z vybéru nebo klepneme na ikonu Novy styl z vybéru na
karté Styly v postranni listé. NapiSeme jméno nového stylu nebo klepneme na existujici jméno
stylu, abychom existujici styl aktualizovali. Potvrdime, odstranime nebo upravime vlastni styl na
karté Styly.

Automatické formatovani bunék

Pouziti automatického formatovani

Automatické formatovani v programu Calc Ize pouzit k rychlému a jednoduchému formatovani
tabulky (oblasti bunék). To také umozni velmi snadné formatovani rliznych ¢asti listu se stejnym
vzhledem. Veskeré pouZzité formatovani je pfimé formatovani.

1) Vybereme buriky, které chceme forméatovat, a to minimalné v rozsahu tfi fadkd a sloupct
vcetné jejich zahlavi.

2) V hlavni nabidce zvolime Format > Styly automatického formatu, ¢imz se otevie
dialogové okno Automaticky format (obrazek 114).

3) V seznamu vybereme typ formatu a barvu formatu.

4) Zvolime, které formatovaci prvky budou pouzity pfi automatickém formatovani.

5) Potvrdime je stisknutim tlaCitka OK.
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Automaticky format

Format

Akademicky

Cerveny seznam
Elegantni

Financni

Jednoduché fadky
Jednoduché sloupce
Jednoduchy stinovany v

Pfidat

Smazat

Prejmenovat

Formatovani
Format &isla Pismo Zarovnani
Chraniéeni Vzor Automaticky pfizplsobit wyiku a Sitku

MNapovéda QK Zrusit

Obréazek 114: Dialogové okno Automaticky format

Definovani nového automatického formatovani

MUGzeme definovat vlastni styl automatického formatovani, ktery bude dostupny pro vSechny

sesity.
1) MidZeme pfitom zvolit typ dat a pisma, velikost pisma, ohrani¢eni bunék, pozadi a dalsi.
2) OznacCime oblast bunék, minimalné o velikosti 4 x 4 buriky.
3) Pro otevfeni dialogového okna Automaticky format vybereme v hlavni nabidce Format >
Styly automatického formatu. Klepneme na tlacitko Pridat.
4) Do pole Nazev v dialogovém okné Pridat automaticky forméat zadame vystizny nazev.
5) Ulozime kliknutim na OK. Nyni je novy format dostupny v seznamu Format v dialogovém
okné Automaticky format.
Q Poznamka

Novy Styl automatického formatu je uloZzen na nasem pocitaci v naSem uzivatelském
profilu a neni dostupny jinym uZivatelim naSeho podcitace. Ostatni uzivatelé si
mohou novy Styl automatického formatu naimportovat tak, Ze oznaci celou tabulku

v otevieném sesité a z této tabulky si vytvofi novy Styl automatického formatu.

Pouzivani témat

Program Calc obsahuje sadu preddefinovanych témat (styld) formatovani, kterd mizeme
pouzivat ve svych seSitech. Do programu Calc neni mozné pridavat nova témata, ale je mozné
upravit styly tématu po tom, co téma pouZzijeme v naSem sesité. Upravené styly jsou pak
pouZzitelné pouze v sesité, ve kterém byly upraveny.
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Jak pouzit téma na seSit:

1) V hlavni nabidce zvolime Format > Motiv vzhledu seSitu nebo klepneme na ikonu
Motiv vzhledu seSitu v nastrojové listé Nastroje, ¢imz otevieme dialogové okno Vybér
motivu vzhledu (obrazek 115).

2) Oznacime téma, které chceme pouzit. Vzhled pouzitého tématu je okamzité viditelny
v otevieném listé.

3) Potvrdime je stisknutim tlacitka OK.

Nyni mizeme otevifit kartu Styly v postranni listé, kde Ize upravit konkrétni styly. Tyto Gpravy
nezméni téma, ale méni pouze vzhled otevieného sesitu. Vice informaci o Upravé styll
nalezneme v kapitole 3, Pouziti styld a Sablon.

Upozornéni

Pouziti nového tématu pres existujici téma prepiSe vSechna dosavadni pfizptsobeni

novym stylem tématu.
Vybér motivu vzhledu X

(Standardni) ~
Be

Dyné

DZinovina

Ledovec

Milénium

Meon

Moc

Mamofnicka modf
Obéd v padesatych
Oslava

OstruZinik

PC nostalgie

Pastel

Podzimni listi

Prirnda

Obrézek 115: Dialogové okno Vybér
tématu

Pouzivani podminéného formatovani

Formétovani bunky je mozné nastavit tak, aby se ménilo podle podminek, které definujeme.
Napfiklad v tabulce ¢isel mizeme zobrazit vSechny hodnoty nad primérem zelenou barvou

a pod prlmérem cervenou barvou. Je mozné zadat a usporadat vice moznosti formatovani
pomoci piifazenych pravidel priority, aby se usporadala dllezitost podminek, coZz umozni, aby
urcité moznosti formatovani probéhly pfed ostatnimi.

Podminéné formatovani zavisi na pouzivani stylll a funkce Automaticky vypocet (Data >
Spocitat > Automaticky vypocet), ktera musi byt zapnuta. Vice informaci se nachazi v kapitole
2, Zadavani, uprava a formatovani dat v prirucce Calc.
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Skryvani a zobrazovani dat

V programu Calc mlzZeme skryt rlizné prvky tak, Ze nebudou viditelné na obrazovce a ani se
nevytisknou pfi tisku seSitu. Skryté prvky vSak Ize kopirovat, jestlize vybereme prvky okolo nich.
Pokud napfiklad skryjeme sloupec B, bude se kopirovat, kdyZ vybereme sloupce A a C. Pokud
budeme chtit skryty sloupec znovu zobrazit, pouZijeme obraceny postup a sloupec zobrazime.

Vice informaci o skryvani a zobrazovani dat, v€etné toho jak pouzivat souhrny a filtrovani se
nachéazi v kapitole 2, Zadavani, Uprava a formatovani dat v pfiru¢ce Calc.

Filtrovani dat

Filtr je seznam podminek, které musi kazda polozka splfiovat, aby mohla byt zobrazena. Calc
poskytuije tfi typy filtrd:

Standardni — urcuje logické podminky pro filtrovani dat.

Automaticky filtr — Filtruje data podle konkrétni hodnoty nebo fetézce. Automaticky filtruje
vybrany rozsah bunék a pfidava do horniho fadku seznamy, ve kterych mdzeme vybrat
polozky, které chceme zobrazit.

RozSiteny filtr — PouZziva kritéria filtru z ur€enych bunék.

Nastaveni a pouzivani filtr(i je popsano v kapitole 2 — Zadavani, Uprava a formatovani dat
v prirucce Privodce programem Calc.

Ochrana bunky

VSechny nebo nékteré burky v tabulce mohou byt chranény heslem, aby se zabranilo zménam
provadénym neautorizovanymi uzivateli. Tato funkce mlze byt prakticka ve chvili, kdy ma do
sesitu pristup vice uzivatell, ale pouze nékolik malo z nich ma povoleno v tomto sesité upravovat
data. Chranéné buriky miZeme volitelné skryt.

S vyuzitim karty Ochrana buriky v dialogovém okné Format bunék (obrazek 116) mizeme
nastavit ochranu burky a prepinat skryty stav chranénych bunék.

Format bunék x

Ochrana
L1 Skryt vie Uzaméeni buriky se uplatni, pouze je-li aktivni
[l Zamknuto uzamdeni piislusného listu.

[ Skrjt vzorec  Vyberte poloZku ‘Uzamknout list' z nabidky ‘Nastroje’,

Tisk
O Skryt pii tisku Vybrané buriky budou pfi tisku vynechany.

Napovéda Obnovit OK Zrusit

Obréazek 116: Karta Ochrana buriky v dialogovém okné Format bunék
KdyZ jsou vSechny poZzadované buiky oznaceny v chranéném nebo nechranéném stavu:

1) Prejdeme v hlavni nabidce do Nastroje > Uzamknout list nebo klepneme pravym
tlacitkem na karté listu a z lokalni nabidky zvolime Uzamknout list. Otevie se dialogové
okno Uzamknout list (obrazek 117).
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2) V ném zvolime Uzamknout tento list a obsah uzaméenych bunék.
3) Zadame a potvrdime zadané heslo.

4) Dle potfeby oznacime nebo zruSime oznaceni v seznamu MoZnosti.
5) Potvrdime je stisknutim tlaCitka OK.

VesSkeré bunky, které byly oznaceny jako chranéné, jiz nebude mozné bez zadani hesla

Uzamknout list X

upravovat.

Uzamknout tento list a obsah uzaméenych bunék

Heslo:

Potvrdit:;

Povolit viem uZivateldm listu:

Vybrat zaméené buriky
Vybrat odeméené buriky

Obrazek 117: Dialogoveé okno Uzamknout list
Uzamceny list m& na své karté ikonu zamku, jak je vidét na obrazku 118.

List1 [ List2 List3 List4
Vyjeh
Obrazek 118: Ikona zamku
uzamceného listu

Pfipadné miZeme zvolit uzamceni struktury celého sesSitu na misto uzamykani jednotlivych
bunék nebo jednotlivych listd. Tohoto docilime vyb&rem Nastroje > Uzamknout strukturu
sesitu v hlavni nabidce. Tato volba umoZziuje chranit seSit proti pfidavani, mazani, pfesouvani
nebo pfejmenovavani listd. Volitelné mdzeme také zadat heslo pomoci dialogového okna
Uzamknout strukturu sesitu.

Razeni zaznam(

Nastroj pro fazeni v programu Calc uspofada buriky v listé podle zadanych kritérii. MiZzeme
zadat najednou vice kritérii, ktera se nasledné pouziji v uréeném pofadi. Razeni je uzite¢né, kdyz
hledame urcitou poloZku, a stane se jesté uzite€néjSim, pokud jej pouzijeme na filtrovana data.
Kromeé toho je sefazeni €asto uzitecné pfi pfidavani novych dat. Kdyz je list dlouhy, je obvykle
jednodussi pfidat nové Udaje dospod listu namisto toho, abychom pridavali nové fadky pfimo na
spravna mista. Po pfidani novych dat mizeme list aktualizovat sefazenim.

Vice informaci o tom, jak tfidit zAznamy, a 0 moznostech tfidéni, najdeme v kapitole 2 —
Zadavani, uprava a forméatovani dat v priru¢ce Calc.

Pokud chceme sefadit buiiky v sesité, pouzijeme dialogové okno Radit:

1) Vybereme bunky, které chceme sefadit.

2) V hlavni nabidce zvolime Data > Radit nebo klepneme na ikonu Radit na standardni
nastrojové listé. V obou pripadech se otevre dialogové okno Radit (obrazek 119).
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3) Na karté Seradit podle vybereme kritéria fazeni z rozbalovacich seznamU. Polozky této
nabidky zaviseji na vybranych burikach.

4) Zvolime vzestupné (AZ, 0-9) nebo sestupné (ZA, 9-0) poradi.
5) Na karté MoZnosti nastavime volby pro fazeni podle potfeby.
6) Klepneme na OK. Data se v seSité sefadi.

Sefadit podle MoZnosti

Kli€ fazeni 1
® Vzestupng
) Sestupné
Kli¢ Fazeni 2
— ® Vzestupna
- nedefinovano - ~ ‘
) Sestupné

KliF Fazeni R

Obréazek 119: Dialogové okno Radit, karta Radit podle

Komentare bunky

Komentéare jsou malé poznamky a texty, které mohou slouzit jako pfipominka nebo upozornéni
pro uzivatele. Komentar neni povaZzovan za €ast seSitu pro vypocty nebo pro Ucely tisku
a zobrazi se pouze tehdy, kdyz mysi prfejedeme nad konkrétni burku, ktera obsahuje komentar.

Nejjednodussi zplisob, jak vlozit komentar, je klepnout pravym tlacitkem mysi na pozadovanou
buriku a vybrat pfikaz VloZit komentar z mistni nabidky. Pfipadné mizZeme zvolit VloZit >
Komentar z hlavni nabidky nebo pouzijeme Ctrl + Alt + C nebo klepneme na ikonu Vlozit
komentar, ktera se nachazi na standardni nastrojové listé.

Ve vychozim nastaveni zUstavaji komentare skryté a zobrazi se pouze pfi najeti mySi na burnku
s komentarem. Buniky, které obsahuji komentére, jsou v pravém hornim rohu oznaceny
¢ervenym obdélnickem. Chceme-li pfepnout viditelnost komentar(, zvolime Zobrazit >
Komentafre v hlavni nabidce.

Vice informaci najdeme v kapitole 11 — Sdileni a prohlizeni sesitd v pfirucce Calc.

Pouziti vzorc a funkci

V sesitu mizeme potiebovat vice nezZ jen Cisla a text. Obsah jedné buriky ¢astokrat zavisi na
obsahu jinych bunék. Vzorce jsou vyrazy, jejichz vysledek je vypocitan pomoci Cisel
a proménnych. Proménné, obsahujici data potfebna pro vypocet, jsou umistény v burikach.

Funkce je pfeddefinovany vypocet vioZzeny do buriky, umoZziujici analyzovat €i zpracovavat data.
Jediné, co musime udélat, je zadat argumenty funkce a vypocet se provede automaticky. Funkce
pomahaiji pfi vytvareni vzorcd, pomoci kterych ziskdme pozadovany vysledek.

Tvorba vzorcu

Funkce a vzorce Ize zadat pfimo do Radku vzorct nebo pomoci funkce Privodce funkci. Pokud
chceme spustit Privodce funkci, klepneme na ikonu Privodce funkci, kterou najdeme vpravo
od Pole nazvu nebo zvolime Vlozit > Funkce v hlavni nabidce nebo stiskneme Ctrl + F2.
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Uvnitf Pravodce funkci miZzeme vyhledavat, vybirat ze seznamu a vybirat funkce podle kategorii.
MUGzeme se také rozhodnout pro Gplné dokonéeni funkce pomoci priivodce, namisto toho,
abychom museli zadavat GpIné vzorce do fadku vzorc(.

Kazda funkce, pokud je zvolena, zobrazi svij struény popis a pouzitelnou syntaxi. Zobrazi se
také dialogova okna, ve kterych miiZzeme zadat informace poZadované danou funkci a okno
vysledkd, které zobrazi vysledek ze zadanych dat.

O Poznamka

Rychla alternativa k Prlivodci funkci je karta Funkce v postranni listé, kde mizeme
funkce rychle vybirat ze seznamu a filtrovat dle kategorii. Tato karta nabizi stru¢né
vysvétleni funkce a jeji syntaxe, ale nenabizi hledani nebo zadavani dat, jako je
tomu v pfipadé plnohodnotného priivodce.

~iws o,

Podrobnéjsi Gvod do syntaxe vzorcl a pouziti Priivodce funkci se najdeme v kapitole 7 — PouZziti
vzorcl a funkci v pfiruc¢ce Calc.

Privodce funkci

Funkce Struktura SUM Wysledek funkce 0

Hledat Vrati soucet viech argumentd,

Kategorie

Cislo 1 (vyZadovano)
Matematické v s

Funkce Cislo 1, ¢islo 2,... jsou argumenty, jejich? soucet se ma zjistit.

SECH A
SERIESSUM

SIGN Cislo1 | fx
SIN

SINH
SQRT Cislo 3 | [

SQRTPI Cislo 4 [
SUBTOTAL

SUMIF

SUMIFS Vzorec
SUMSQ —sum() A
TAN
TANH
TRUNC v v

Cislo 2 | [

1 BRI NI N

Vysledek |0

] Matice Napovéda < Zpét Dalsi = QK Zrusit

Obréazek 120: Privodce funkci

Analyza dat

Program Calc obsahuje nékolik nastrojd, které usnadniuji analyzu dat v seSitech. Pro nase ucely
se mohou hodit napfiklad funkce na kopirovani a opétovné pouzivani dat, funkce na automatické
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vytvareni mezisouctd nebo funkce uréené k ménéni dat. Tyto nastroje se nachazeji v nabidkach
Nastroje a Data.

Calc také obsahuje mnoho néastrojl pro analyzu statistickych dat, kde mizeme ziskat dilezité
¢iselné informace z Udajd ziskanych fyzikalnim mérenim, anketou, nebo dokonce obchodni
transakci, jako je prodej, akciova citace a tak dale. Tyto analyzy dat jsou k dispozici v listé
nabidky Data > Statistika.

Vice informaci o nastrojich pro analyzu dat v programu Calc najdeme v kapitole 9 — Analyza dat
v prirucce Calc.

Kontingenéni tabulky a kontingen€ni grafy

v

usporadat, manipulovat a shrnout velké mnoZstvi dat, aby je bylo mnohem snazsi Cist

a porozumét jim, a zaroven umozni zodpovidat riizné otazky tykajici se tabulky tim, Ze data
v tabulce preskupi a nebo shromazdi. Pomoci kontingenéni tabulky mdzeme zobrazit rizné
souhrny zdrojovych dat, zobrazit detaily v oblastech, které nas zajimaji a vytvaret sestavy.
MUdZeme také vytvorit kontingencni graf, ve kterém graficky zobrazime data z kontingencni
tabulky.

Napfiklad mizeme mit tabulku obsahujici seznam dar( pro rlizné charitativni organizace, které
vybrala skupina pracovnikl v riznych mésicich, ale zajima nas pouze to, kolik kazdy pracovnik
vybral celkem. Mohli bychom tuto ¢astku vypocitat manualné pomoci tfidéni a moznosti
formatovani, které nabizi program Calc. Nebo mizeme vytvorit kontingenéni tabulku, abychom
mohli data jednoduSeji usporadat a Cist.

Pokud chceme vytvofit kontingencni tabulku, zvolime Data > Kontingené€ni tabulka > VloZit
nebo upravit v hlavni nabidce nebo klepneme na ikonu VloZit nebo upravit kontingenéni
tabulku na standardni listé nastrojl. Dialogové okno Rozvrzeni kontingenéni tabulky navrhne
zahlavi sloupcll z vybranych nezpracovanych dat a vlozi je do ¢asti Dostupna pole. Odtud
mlZeme pretdhnout pozadované informace do poli pro sloupec, fadek, data nebo filtr, abychom
je usporadali podle pozadavkd, a klepnutim na OK zobrazime vysledky.

Pokud chceme zvolit nové informace, které chceme zobrazit, nebo pokud chceme zménit
rozlozeni existujicich informaci, otevieme mistni nabidku klepnutim pravym tlacitkem mysSi
kdekoli v existujici kontingenc¢ni tabulce a vybereme volbu Vlastnosti. Ke stejnému dialogovému
oknu se také miizeme dostat pomoci volby Data > Kontingenéni tabulka > VloZit nebo upravit
z hlavni nabidky nebo klepnutim na ikonu VloZit nebo upravit kontingenéni tabulku, kterou
najdeme na standardni nastrojové listé.

Podrobnéjsi vysvétleni kontingencénich tabulek a predpokladl nutnych pro jejich pouziti najdeme
v kapitole 8 — PouZiti kontingen¢nich tabulek v pfiru¢ce Calc.

Kontingenéni grafy

Pokud chceme ziskat rychlou vizualni reprezentaci dat obsazenych v kontingenc¢ni tabulce,
mlZeme vygenerovat kontingenéni graf. Funkéné jsou kontingenéni grafy totoZné s béznymi
grafy s vyjimkou dvou klicovych oblasti. Za prvé se pfi zméné dat v kontingencni tabulce se
kontingenc¢ni graf automaticky upravi. Za druhé zahrnuje tlacitka poli — grafické prvky, které
umoznuiji filtrovat obsah kontingencni tabulky pfimo v samotném kontingencnim grafu.

Dalsi informace o kontingenénich grafech a grafech obecné najdeme v kapitole 3 — Tvorba grafl
a v kapitole 8 — Pouziti kontingencnich tabulek v priru¢ce Calc.
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Tisk

Tisk z programu Calc je velmi podobny tisku z jinych ¢asti LibreOffice (podrobnosti se nachazeji
v kapitole 10 — Tisk, exportovani, odesilani a podepisovani dokumentt). Nékteré detaily tisku
v programu Calc se vSak lisi. A to zejména pfi priprave tisku.

Po definovani oblasti tisku jsou tyto oblasti formatovani automatickym zalomenim stranky. Pokud
chceme zobrazit konce stranek, zvolime v hlavni nabidce Zobrazit > Zalomeni stranky.

Oblasti tisku

Oblasti tisku maji nékolik vyuziti, napfiklad tisk stanovené ¢asti dat nebo tisk vybranych fadku
nebo sloupctd na kazdé strance. Dalsi informace o pouziti tiskového rozsahu najdeme v kapitole
6 — Tisk, exportovani, odesilani a podepisovani v pfirucce Calc.

Definovani oblasti tisku
Kdyz chceme definovat novou oblast tisku nebo upravit existujici:

1) Vybereme oblast bunék, kterd ma byt v oblasti tisku zahrnuta.

2) V hlavni nabidce zvolime Format > Oblasti tisku > Definovat. Automaticka zalomeni
stranek jsou viditelna na obrazovce.

3) Pokud chceme zkontrolovat tiskové rozsahy, zvolime v hlavni nabidce Soubor > Nahled
tisku, stiskneme Citrl + Shift + O nebo klepneme na ikonu Pfepnout nahled tisku na
standardni nastrojové listé. Aplikace Calc zobrazi pouze bunky v oblasti tisku.

Pridavani k oblasti tisku
Po nadefinovani oblasti tisku do ni mizeme pfidat dalsi buriky tak, Ze vytvofime novou oblast
tisku. Takto mlZzeme z listu vytisknout nékolik nesouvislych oblasti.

1) Po definovani oblasti tisku vybereme novou oblast bunék, kterou chceme pfidat.

2) Dalsi buiiky oblasti tisku pfidame volbou Format > Oblast tisku > Pfidat v hlavni
nabidce. Cary rozdélujici list na stranky jiZ na obrazovce nebudou viditelné.

3) Pokud chceme zkontrolovat tiskové rozsahy, zvolime v hlavni nabidce Soubor > Nahled
tisku, stiskneme Ctrl + Shift + O nebo klepneme na ikonu Pfepnout nahled tisku na
standardni nastrojové listé. LibreOffice jednotlivé oblasti tisku zobrazi jako oddélené
stranky.

Poznamka

Pfidana oblast tisku se vytiskne jako samostatna stranka, a to i v pfipadé, pokud
jsou obé oblasti na stejném listé.

Odstranéni oblasti tisku

MUZe se stat, Ze je potfeba definovanou oblast tisku odstranit, napfiklad pokud chceme pozdéji
vytisknout cely list.

VSechny oblasti tisku odstranime tak, Ze v hlavni nabidce zvolime Format > Oblasti tisku >
Odstranit. Po odstranéni oblasti tisku se na obrazovce zobrazi vychozi Cary znazornujici
zalomeni stranek.

Uprava oblasti tisku

Oblast tisku miZzeme kdykoliv upravit, napfiklad pokud chceme odstranit nebo zménit velikost jeji
¢asti. V hlavni nabidce zvolime Format > Oblasti tisku > Upravit. Tim otevieme dialogové okno
Upravit oblasti tisku, kde Ize oblasti definovat.
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Moznosti tisku

KdyZ chceme nastavit moznosti souvisejici s uspofadanim a podrobnostmi stréanek a jejich
meéfitkem:

1) V hlavni nabidce zvolime Format > Stranka. Otevie se dialogové okno Styl stranky
(obrazek 121).

2) V ném vybereme kartu List, kde nastavime jednotlivé moZnosti dle svych potieb.
Klepneme na OK.

Styl stranky: Vychozi

Organizator Stranka Ohraniceni Pozadi Zahlavi Zapati
Uspofadani stranky

® Shora dol(, potom vpravo

(O Zleva doprava, potom dold

Cislo prvni stranky: 1

Tisk
[ Zzahlavi sloupcl a Fadka ¥ Grafy
[ Mrizka Objekty kresby
[ Komentare O Vzorce
Objekty/obrazky Nulové hodnoty
MEéritko
ReZim nastaveni méfitka: ‘Upravit méfitko tisku ~ ‘

Méfitko: 100 %

Obréazek 121: Dialogové okno Styl stranky — karta Stranka

Zopakovani tisku fadk( a sloupcti

Pokud se list tiskne na vice stranek, je mozné nastavit, aby se nékteré radky nebo sloupce na
kazdeé strance opakovaly. Pokud napfiklad potfebujeme, aby byly na kazdé strance vytiStény
prvni dva fadky listu, budeme postupovat nasledovné:

1) V hlavni nabidce zvolime Format > Oblasti tisku > Upravit a otevie se dialogové okno
Upravit oblasti tisku (obrazek 122).

2) Do pole Opakovat radky zadame identifikatory fadku. Pokud chceme napfiklad opakovat
fadky 1 a 2, zadame $1:$2. To automaticky zméni hodnotu rozbalovaciho seznamu
Opakovat radky z hodnoty - Zzadné - na - definované uzivatelem -.

3) V poli Opakovat sloupce zadame identifikatory sloupce. Pokud chceme napfiklad
opakovat sloupec A, zadame $A. Automaticky zméni hodnotu rozbalovaciho seznamu
Opakovat sloupce z hodnoty - Zadné - na - definované uzivatelem -.

4) Potvrdime je stisknutim tlaCitka OK.

Dalsi informace o Upraveé oblasti tisku najdeme v kapitole 6 — Tisk, exportovani, odesilani
a podepisovani v priru¢ce Privodce programem Calc.
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Upravit oblasti tisku

Oblast tisku

= |

- cely list - v]

Opakovat radky

= |

|— definované uZivatelem - |~ ‘ £1:83

Opakovat sloupce

= |

|— definované uZivatelem - | ~ ‘ A

Napoveda OK Zrusit

Obréazek 122: Dialogové okno Upravit oblasti tisku

Zalomeni stranky

Prestoze definovani rozsahu tisku mdze byt vykonnym nastrojem, mdéze byt nékdy nutné
manualné upravit vytisk z programu Calc pomoci ru¢niho zalomeni stranky. Ru¢ni zalomeni
pomaha zajistit, aby se data vytiskla se spravnou velikosti a orientaci vzhledem k nastaveni
stranky. Vodorovné zalomeni stranky mdzeme vloZit nad aktivni buriku, svislé vlevo od aktivni
buriky.

Vkladani zalomeni stranky
KdyZ chceme zalomeni stranky vloZit:
1) Prejdeme do burky, od které ma zacit nova strana.

2) V hlavni nabidce zvolime List > VloZit zalomeni stranky.

3) Vybérem polozky Zalomeni fadku vytvofime zalomeni stranky nad vybranou burikou.
Vybérem polozky Zalomeni sloupce vytvofime zalomeni stranky vlevo od vybrané
buniky.

Mazani odstranéni

Kdyz chceme zalomeni stranky odstranit:
1) Prejdeme do buriky, ktera nasleduje za zalomenim, které chceme odstranit.
2) V hlavni nabidce zvolime List > Smazat zalomeni stranky.

7 vz

3) Podle potfeby vybereme polozku Zalomeni fadku nebo Zalomeni sloupce.

(_/ Poznamka
Na jediné strance muze byt nékolik ruénich zalomeni fadkl a sloupci. Kdyz je
chceme odstranit vSechna, je tfeba tak provést po jednom.

DalSi informace o ru€ni Upravé zalomeni najdeme v kapitole 6 — Tisk, exportovani, odesilani
a podepisovani v pfiru¢ce Privodce programem Calc.

Zahlavi a zapati

Zahlavi a zapati jsou preddefinované €asti textu, které se vytisknou v horni a dolni ¢4sti stranky.
Zahlavi a zapati se definuji a nastavuji stejné. DalSi informace o nastaveni a definovani zahlavi
a zapati najdeme v kapitole 6 — Tisk, exportovani, odesilani a podepisovani v pfirucce Privodce
programem Calc.
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Zahlavi a zapati jsou pfifazena ke stylu stranky. V jednom sesité mlizeme pouzit vice nez jeden
styl stranky a pfifadit rozdilné styly riznym listdm. Vice informaci o stylech stranky v programu
Calc nalezneme v kapitole 4 — Pouziti styll a $ablon v pfiru¢ce Privodce programem Calc.

Nastaveni zahlavi nebo zapati
Kdyz chceme nastavit zahlavi nebo zapati:

1)
2)

3)
4)

5)

6)

7

Prejdeme na list, kterému chceme nastavit zahlavi nebo zapati.

V hlavni nabidce zvolime Format > Stranka. Otevie se dialogové okno Styl stranky
(obrazek 123) a vybereme kartu Zahlavi nebo Zapati (obrazek 123).

ZaSkrtneme Zahlavi zapnuto nebo Zapati zapnuto.

Pokud chceme mit stejné zahlavi nebo zapati na vSech vytisténych strankach,
zaskrtneme volbu Stejny obsah na levych a pravych strankéach.

Na tomto misté také mlizZeme nastavit okraje, mezery a vysku zahlavi nebo zapati.
MdlZeme také zaSkrtnout pole Automaticka tprava vysky, kterym se nastavi
automaticka vyska zahlavi nebo zapati.

Kdyz chceme zménit vzhled zahlavi nebo zapati, klepneme na tlagitko Vice. Otevre se
dialogové okno pro nastaveni ohranieni a pozadi.

Obsah, ktery se ma v zahlavi nebo zapati zobrazit, jako napfiklad €islo stranky, datum
a podobné, nastavime v dialogovém okné Zahlavi (nebo Zapati), které se objevi po
klepnuti na tlaitko Uprauvit.

Styl stranky: Zprava

Organizator Stranka Ohrani¢eni Pozadi Zahlavi Zapati List
Zahlavi
Stejny obsah na levych a pravych strankach

Levy okraj: 0,00 cm = e
Pravy okraj: 0,00 cm =
Mezery: 0,25 cm =
Vyika: 0,50 cm =

Automaticka dprava vyiky

Vice... Upravit...
Obrazek 123: Karta Zahlavi v dialogovém okné Styl stranky
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